
 Printed on 28 August, 2007 

Rhythmyx 

Customizing 
Content Explorer 

Version 6.5.2 
 
 
 



Copyright and Licensing Statement 
All intellectual property rights in the SOFTWARE and associated user documentation, implementation 
documentation, and reference documentation are owned by Percussion Software or its suppliers and are 
protected by United States and Canadian copyright laws, other applicable copyright laws, and 
international treaty provisions.  Percussion Software retains all rights, title, and interest not expressly 
grated.  You may either (a) make one (1) copy of the SOFTWARE solely for backup or archival purposes 
or (b) transfer the SOFTWARE to a single hard disk provided you keep the original solely for backup or 
archival purposes.  You must reproduce and include the copyright notice on any copy made.  You may not 
copy the user documentation accompanying the SOFTWARE. 

The information in Rhythmyx documentation is subject to change without notice and does not represent a 
commitment on the part of Percussion Software, Inc.  This document describes proprietary trade secrets of 
Percussion Software, Inc.  Licensees of this document must acknowledge the proprietary claims of 
Percussion Software, Inc., in advance of receiving this document or any software to which it refers, and 
must agree to hold the trade secrets in confidence for the sole use of Percussion Software, Inc. 

The software contains proprietary information of Percussion Software; it is provided under a license 
agreement containing restrictions on use and disclosure and is also protected by copyright law.  Reverse 
engineering of the software is prohibited. 

Due to continued product development this information may change without notice.  The information and 
intellectual property contained herein is confidential between Percussion Software and the client and 
remains the exclusive property of Percussion Software.  If you find any problems in the documentation, 
please report them to us in writing.  Percussion Software does not warrant that this document is error-free. 

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or 
by any means, electronic, mechanical, photocopying, recording or otherwise without the prior written 
permission of Percussion Software. 

Copyright © 1999-2007 Percussion Software. 
All rights reserved 

Licenses and Source Code 
Rhythmyx uses Mozilla's JavaScript C API.  See http://www.mozilla.org/source.html 
(http://www.mozilla.org/source.html) for the source code.  In addition, see the Mozilla Public License 
(http://www.mozilla.org/source.html). 

Netscape Public License  

Apache Software License 

IBM Public License 

Lesser GNU Public License 

Other Copyrights 
The Rhythmyx installation application was developed using InstallShield, which is a licensed and 
copyrighted by InstallShield Software Corporation. 

The Sprinta JDBC driver is licensed and copyrighted by I-NET Software Corporation. 

The Sentry Spellingchecker Engine Software Development Kit is licensed and copyrighted by Wintertree 
Software. 

The Java™ 2 Runtime Environment is licensed and copyrighted by Sun Microsystems, Inc. 

http://www.mozilla.org/source.html
http://www.mozilla.org/source.html


The Oracle JDBC driver is licensed and copyrighted by Oracle Corporation. 

The Sybase JDBC driver is licensed and copyrighted by Sybase, Inc. 

The AS/400 driver is licensed and copyrighted by International Business Machines Corporation. 

The Ephox EditLive! for Java DHTML editor is licensed and copyrighted by Ephox, Inc. 

This product includes software developed by CDS Networks, Inc. 

The software contains proprietary information of Percussion Software; it is provided under a license 
agreement containing restrictions on use and disclosure and is also protected by copyright law.  Reverse 
engineering of the software is prohibited. 

Due to continued product development this information may change without notice.  The information and 
intellectual property contained herein is confidential between Percussion Software and the client and 
remains the exclusive property of Percussion Software.  If you find any problems in the documentation, 
please report them to us in writing.  Percussion Software does not warrant that this document is error-free. 

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or 
by any means, electronic, mechanical, photocopying, recording or otherwise without the prior written 
permission of Percussion Software. 

AuthorIT™ is a trademark of Optical Systems Corporation Ltd. 

Microsoft Word, Microsoft Office, Windows®, Window 95™, Window 98™, Windows NT®and MS-
DOS™ are trademarks of the Microsoft Corporation. 

This document was created using AuthorIT™, Total Document Creation (see AuthorIT Home - 
http://www.author-it.com). 

Schema documentation was created using XMLSpy™. 

Percussion Software 
600 Unicorn Park Drive 
Woburn, MA 01801 U.S.A. 
 781.438.9900 
Internet E-Mail: technical_support@percussion.com 
Website: http://www.percussion.com 

 

http://www.author-it.com/




 

 i 
 

Contents 

Maintaining Community Objects 5 
CMS Navigator - Security Design ................................................................................................................6 
Community Visibility ...................................................................................................................................8 
New Community Wizard ............................................................................................................................10 
Community Editor ......................................................................................................................................12 
Creating a Community................................................................................................................................14 
Editing a Community..................................................................................................................................15 
Deleting a Community................................................................................................................................16 

Maintaining Menus and Menu Entries 17 
New Menu Wizard......................................................................................................................................19 
New Menu Entry Wizard............................................................................................................................21 
Menu and Menu Entry Editor .....................................................................................................................23 

Menu and Menu Entry Editor, General Tab for Menus...................................................................24 
Menu and Menu Entry Editor, General Tab for Menu Entries ........................................................26 
Window Style Dialog ......................................................................................................................28 
Menu and Menu Entry Editor, Usage Tab.......................................................................................29 
Menu and Menu Entry Editor, Command Tab ................................................................................33 
Menu and Menu Entry Editor, Visibility Tab..................................................................................36 

Creating a Menu .........................................................................................................................................39 
Creating a Menu Entry................................................................................................................................40 
Adding Properties to a Menu or Menu Entry..............................................................................................41 
Editing a Menu or Menu Entry ...................................................................................................................43 
Dragging and Dropping Menu Entries to Menus........................................................................................45 
Deleting a Menu .........................................................................................................................................46 
Deleting a Menu Entry................................................................................................................................47 

Maintaining Display Formats 49 
New Display Format Wizard ......................................................................................................................51 
Display Format Editor ................................................................................................................................53 
Creating a Display Format ..........................................................................................................................55 
Customizing a Display Format ...................................................................................................................56 
Modifying a Display Format.......................................................................................................................57 
Deleting a Display Format ..........................................................................................................................58 
Adding Graphics to Display Formats .........................................................................................................59 

Using Images in Display Format Columns......................................................................................59 
Adding Thumbnail Previews to Display Formats............................................................................60 

Maintaining Searches 61 
New Search Wizard ....................................................................................................................................62 
Search Editor, Standard Search...................................................................................................................64 

Standard Database Search Editor.....................................................................................................65 
Standard Full Text Search Editor ....................................................................................................68 



 

ii Contents 
 

Search Editor, Custom Search ....................................................................................................................71 
Configuring Community Searches..............................................................................................................73 
Creating a Search........................................................................................................................................74 
Customize a Standard Search .....................................................................................................................75 
Configure a Custom Search ........................................................................................................................76 

Building a Custom Search Application ...........................................................................................76 
Modify a Standard Search...........................................................................................................................78 
Modify a Custom Search ............................................................................................................................79 
Setting New Searches for Communities .....................................................................................................80 
Deleting a Search........................................................................................................................................81 

Maintaining Content Explorer Views 83 
New View Wizard ......................................................................................................................................84 
View Editor.................................................................................................................................................86 

Standard View Editor ......................................................................................................................86 
Custom View Editor ........................................................................................................................87 

Creating a New Content Explorer View .....................................................................................................89 
Configuring a Standard Content Explorer View.........................................................................................91 
Configuring a Custom Content Explorer View...........................................................................................92 

Building a Custom View Application..............................................................................................92 
Modifying a Standard View........................................................................................................................96 
Modifying a Custom View .........................................................................................................................97 
Deleting a Content Explorer View..............................................................................................................98 

Field Selection Editor 99 
Selecting Fields used in Display Formats, Views, and Searches ..............................................................101 

Extending Lifecycle Analysis Reporting 103 
Updating the Rhythmyx Lifecycle Analysis Workbook...........................................................................105 
Access Control for Lifecycle Analysis Reports ........................................................................................107 
Modifying the Fields in Standard Lifecycle Analysis Reports .................................................................108 

Example Modification of a Lifecycle Analysis Report Resource..................................................109 
Adding Custom Lifecycle Analysis Report Resources.............................................................................111 

Example Creation of a Custom Lifecycle Analysis Report Resource ...........................................111 



 

 Contents iii 
 

Implementing Lifecycle Analysis in Additional Clients...........................................................................115 
Passing HTML Parameters to a Lifecycle Analysis Resource..................................................................116 
Upgrading Lifecycle Analysis ..................................................................................................................117 

Customizing DocuComp Integration 119 

Making Rhythmyx Accessible to Visually Impaired Users 121 
Using Content Explorer with a Screen Reader .........................................................................................122 

Setting up the Active Assembly Tutorial 123 
Creating a Test Site...................................................................................................................................125 
Refreshing the Test Site............................................................................................................................132 

Index 133 

  





 

 5 
 

Maintaining Community Objects 
A Community represents a group of roles that require access to similar information in Rhythmyx. A role 
can be associated with more than one Community, and users belong to all of the Communities associated 
with their roles.   

Rhythmyx will only grant users access to those Content Editors, Workflows, user interface components, 
Sites, and Templates that are associated with their Communities. 

You create and edit Communities in the Rhythmyx Workbench. In the Rhythmyx Workbench: 

 Use the Security Design view (see "CMS Navigator - Security Design" on page 6) to see the 
Communities in your system and the Roles associated with them. 

 Use the Community Visibility view (see "Community Visibility" on page 8) to associate 
Rhythmyx objects with Communities. 

 Use the Community Wizard (see "New Community Wizard" on page 10) to create new 
Communities. 

 Use the Community Editor (on page 12) to edit and maintain existing Communities. 
In the Rhythmyx Workbench, you can: 

 Create a Community (see "Creating a Community" on page 14). 
 Edit a Community (see "Editing a Community" on page 15). 
 Delete a Community (see "Deleting a Community" on page 16). 

You associate Roles with Communities in the Rhythmyx Server Administrator. 

A content item is automatically associated with the community of the user who creates it.     

The way you configure user's Communities affects each user's login procedure: 

 If the user role has one Community or a default Community defined, Rhythmyx logs the user 
in for that Community.  

 If users have more than one Community and no default Community defined, Rhythmyx 
displays the Community Login page to them, so they can select a log-in Community.  

 If the user clicks the Communities button  in the User Status box in the Content Explorer, 
Rhythmyx displays the Community Login page, and the user can select a new log-in 
Community. 

 The Default Community (sys_defaultCommunity) is a property of the user's role.  
Define it in the Server Administrator. 
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CMS Navigator - Security Design 
The Security Design view of the Rhythmyx Workbench's CMS Navigator displays Security objects. 

The main objects in the Security Design view are Communities and Roles. Below, descriptions of these 
objects and their children follow the graphical representation of the view. 

 
Figure 1: SecurityDesignView 

Roles Folder 
Roles folder includes folders representing three categories of Roles. Theoretically, users should not 
associate Roles with both a Community and a Workflow; however, associating a Role with both is 
permitted. 

 Communities - contains references to Roles that are members of a Community. 
 Functional - contains references to Roles that have access to a Workflow.  
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 Unassigned - contains references Roles that are not members of a Community and do not have 
access to a Workflow. 

In all Rhythmyx Workbench views, references to Roles rather than actual Roles are listed because 
Roles are edited in the Rhythmyx Server Administrator rather than the Rhythmyx Workbench. 

Communities Folder 
The Communities folder contains all Communities in the CMS. Each Community contains references to 
the Roles that are associated with it. For a more detailed view of Communities, see Community Visibility 
(on page 8). 
 



 

8 Rhythmyx Customizing Content Explorer 
 

Community Visibility 
Use the Rhythmyx Workbench's Community Visibility view to view or edit the objects that are visible to 
the members of a Community. The Community Visibility view lists all Communities on the Rhythmyx 
Server and displays the objects to which each Community has access. 

 
Figure 2: Community Visibility View 

The types of objects that can be visible to a Community are Content Types, Display Formats, Menus and 
Menu Entries, Searches, Sites, Templates and XSL Variants, Views, and Workflows. If you have modify 
ACL access to the object, you can drag and drop (or copy and paste) it from the following views to the 
Community which has access to it: 

Object Drag from . . .   
Content Types Content View 
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Object Drag from . . .   
Templates Assembly View 

Menus and Menu Entries, Display Formats, Searches, 
Views 

User Interface Elements View 

Sites, Workflows System Design View 

XSL Variants XML Server 
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New Community Wizard 
The New Community wizard creates new Communities in Security Design view (see "CMS Navigator - 
Security Design" on page 6). 

To access the New Community wizard: 

 In Security Design view (see "CMS Navigator - Security Design" on page 6), right-click on 
the Communities folder and choose New > Community. 

 From the Menu bar choose File > New > Other. In the Select a Wizard dialog, expand the 
Rhythmyx CMS folder and choose Community. Click [Next]. 

 
Figure 3: New Community Wizard 
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Field Descriptions 
Community name - The name of the Community.  

Description - An explanation of the Community and its purpose. 

Available roles - The roles that are accessible for assignment to the Community. 

Assigned roles - The roles that are allocated to the Community. 
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Community Editor 
Use the Community editor to add or remove roles that are associated with a Community. 

To access the Community editor: 

 After completing the Community wizard, click [Finish]. 
 Right-click on the Community object in any view that displays it and select Open. 
 Double-click on the Community object in any view that displays it. 

 
Figure 4: Community Editor 

Field Descriptions 
Community name - Read only. The name of the Community. 
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Description - An explanation of the Community and its purpose. 

Available roles - The roles that are accessible for assignment to the Community. 

Assigned roles - The roles that are allocated to the Community. 
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Creating a Community 
Use the New Community wizard to create a new Community and assign Roles to it.   Note that when you 
create a new Community, any object whose Access Control List specifies that it is available to All 
Communities will automatically be added to the new Community. 

For a graphic of the wizard and definitions of the fields discussed below, see New Community Wizard (on 
page 10). 

To create a Community: 

1 In Security Design view (see "CMS Navigator - Security Design" on page 6), right-click on 
the Communities folder and choose New > Community.   

The New Community wizard opens. 

2 Enter a unique name in the Community name field.  

3 Optionally, enter a Description. 

4 In Available roles, select the Roles in the you would like to add to the Community. Use [ALT 

+ click] to select multiple Roles. Click  to move them to Assigned roles. 

5 If you want to move a Role back to the Available roles column, select the Role in the Assigned 
roles column and click . 

6 You can also move all of the Roles from one column to the other by clicking [<<] or [>>]. 

7 Click [Finish].  
The New Community wizard closes and the Community editor opens. The Community 
appears under the Community folder in Security Design view (see "CMS Navigator - Security 
Design" on page 6).  

The Community editor displays the same fields as the New Community wizard. 

Now you can: 

 Save and close the Community editor, since it does not include any additional fields. 
 Go to Community Visibility view (see "Community Visibility" on page 8) and modify the 

Rhythmyx components available to the Community. 
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Editing a Community 
For a graphic of the editor and definitions of the fields discussed below, see Community Editor (on page 
12). 

To update or edit a Community:  

1 Change the Description. 

2 Make the necessary changes to the community and click the Finish button when you are done. 
Rhythmyx will validate that the name is unique name among all communities. You will not be 
allowed to proceed to the next step if the name you enter is already in the system. 

3 Click the Close button to exit the Update Community dialog box. 

4 In Available roles, select Roles that you would like to add to the Community. Use [ALT + 

click] to select multiple Roles. Click  to move them to Assigned roles. 
5 If you want to move a Role back to the Available roles column, select the Role in the Assigned 

roles column and click . 

6 You can also move all of the Roles from one column to the other by clicking [<<] or [>>]. 

7 Save and close the editor. 
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Deleting a Community 
To delete a Community: 

1 In Security Design view (see "CMS Navigator - Security Design" on page 6), right-click on 
the Community and choose Delete. 

2 The Community is deleted from Rhythmyx. 

When you delete a Community, any associations of Rhythmyx elements with that Community 
are also removed. However, the elements are not deleted from Rhythmyx. Likewise, If Roles 
are assigned to Communities, the assignments are removed but the Roles are not removed 
from Rhythmyx.  
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Maintaining Menus and Menu 
Entries 
Menus provide the functions available to Content Items and Folders in various Content Explorer locations 
or contexts.  Menu entries are the choices that are listed in menus. Menu entries are not children of any 
Menu and can be associated with multiple menus. Typical menu entries enable functions such as editing 
Content Items, performing Workflow Transitions, and implementing Relationships (for example, creating 
new Active Assembly Relationships, or new Copies, Versions, or Translation Copies of Content Items).  
Menus may be nested to any number of layers.  

Most frequently, menus appear as pop-ups that open when you right-click on a Content Item or Folder or 
as sub-menus of other menus. In some circumstances, menus appear as Action Panels. Action Panels 
behave in the same way as Menus, but some menu entries for action panels have required names. 

For more information about Relationships and Workflows in Rhythmyx, see the documents Implementing 
the Relationship Engine and Maintaining Workflows in Rhythmyx. 

 
Figure 5: Example of Action Menus 

Create Menus and Menu Entries in the Rhythmyx Workbench: 

 Use the New Menu wizard (on page 19) to create a new menu. 
 Use the New Menu Entry wizard (on page 21) to create a new menu entry. 
 Use the Menu and Menu Entry editor (on page 23) to complete and maintain menus and 

menu entries. 

You can: 

 Create a basic menu object (see "Creating a Menu" on page 39) 
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 Create a basic menu entry object (see "Creating a Menu Entry" on page 40) 
 Add properties to menus and menu entries (see "Adding Properties to a Menu or Menu 

Entry" on page 41). 
 Edit properties of menus and menu entries (see "Editing a Menu or Menu Entry" on page 

43). 
 Delete menus (see "Deleting a Menu" on page 46) 
 Delete menu entries (see "Deleting a Menu Entry" on page 47) 
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New Menu Wizard 
The Rhythmyx Workbench's New Menu wizard allows you to create a new menu object that appears in 
the UI Elements Design view; however, you must add properties in the Menu and Menu Entry editor (see 
page 23) to make the menu usable. 

To access the New Menu wizard: 

 From the Menu bar choose File > New > Other. In the Select a wizard dialog, choose Menu. 
 In UI Elements view, expand the Content Explorer folder. Right-click on Menus and choose 

New > Menu. 

 
Figure 6: New Menu Wizard 

Field Definitions 
Menu name - Required. System name of menu. 
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Label - Required. Name displayed to users for menu. 

Description - Description of menu. 

Menu Type - One of the following options is required: 

Cascading 
menu 

A menu whose entries are manually assigned to it. 

Dynamic menu A menu whose entries are selected by an application when 
the menu is accessed. 
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New Menu Entry Wizard 
The Rhythmyx Workbench's New Menu Entry wizard allows you to create new menu entries that appear 
in the UI Elements Design view under the Menu Entries' User Folder; however, by default new Menu 
Entries are not available for any Content Explorer components; you must make it available in the Menu 
and Menu Entry editor (on page 23). 

To access the Menu Entry wizard: 

 In UI Elements view, from the Menu bar choose File > New > Other. In the Select a wizard 
dialog, choose Menu Entry. 

 In UI Elements view, expand the Content Explorer folder. Right-click on Menu Entries and 
choose New > Menu Entry. 

 
Figure 7: New Menu Entry Wizard 
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Field Definitions 
Menu entry name - Required. System name for menu entry. 
Label - Required. Name displayed to users for menu entry. 
Description - Description of menu. 
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Menu and Menu Entry Editor 
The Rhythmyx Workbench's Menu and Menu Entry editor allows you to add and edit properties of Menus 
and Menu Entries, including where they are accessible in Content Explorer. 

To access the Menu and Menu Entry editor: 

 After completing the New Menu wizard (see page 19) or the Menu Entry wizard (see "New 
Menu Entry Wizard" on page 21), click [Finish]. 

 Right-click on the menu or menu entry object in any view that displays it and select Open. 
 Double-click on the Menu or Menu Entry object in any view that displays it. 

The Menu and Menu Entry editor includes four tabs: 

 General tab, which differs for Menus (see "Menu and Menu Entry Editor, General Tab for 
Menus" on page 24) and for Menu Entries (see "Menu and Menu Entry Editor, General Tab 
for Menu Entries" on page 26) 

 Usage tab (see "Menu and Menu Entry Editor, Usage Tab" on page 29) 
 Command tab (see "Menu and Menu Entry Editor, Command Tab" on page 33) 
 Visibility tab (see "Menu and Menu Entry Editor, Visibility Tab" on page 36) 
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Menu and Menu Entry Editor, General Tab for Menus 
When a menu opens in the Menu and Menu Entry Editor, the General tab displays general properties of 
the menu. 

Use this tab to: 

 add general properties of a Menu. (see "Adding Properties to a Menu or Menu Entry" on 
page 41) 

 edit general properties of a Menu (see "Editing a Menu or Menu Entry" on page 43). 

 
Figure 8: Menu and Menu Entry Editor, General tab for menus 

Field Descriptions 
Menu name - Read-only. System name for menu. 
Menu label - Required. Name displayed to users for menu. 
Description - Description of menu. 
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Type - One of the following options is required: 

Cascading menu A menu that only includes menu entries that are manually 
dragged and dropped into the menu. 

Dynamic menu A menu whose menu entries are generated by an application 
when the user accesses the menu. For example, a Workflow 
menu is dynamic because Rhythmyx uses an application to 
generate its entries depending on the Content Item's State. 

Accelerator - Keyboard shortcut for opening this menu after choosing it. The keys control, shift and 
alt are supported and can be combined with a character. The keys DELETE and INSERT are supported 
as well. Examples are: "INSERT", "control DELETE", and "alt shift X". 
Sort rank - Sort order of menu label when it is listed in another menu. If several menus have the same Sort 
rank, they are sorted alphabetically within that rank. By default, Sort rank is 1, which causes a menu label 
to be placed first within a menu or alphabetically among other menus with a Sort rank of 1. 

Mnemonic - Letter or character for selecting this menu when it is listed in another opened menu. An 
accessibility feature. 

Tooltip - Brief description of the menu displayed when the mouse hovers over the menu label. 

Icon path - The path, relative to the Rhythmyx root, to the graphic for the menu icon.  For example, 
rx_resource/images/edit.gif.  Rhythmyx displays the specified graphic beside the menu label: 

 . 
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Menu and Menu Entry Editor, General Tab for Menu 
Entries 
When a menu entry opens in the Menu and Menu Entry Editor, the General tab displays general properties 
of the menu entry. 

Use this tab to: 

 add general properties of a Menu Entry. (see "Adding Properties to a Menu or Menu Entry" 
on page 41) 

 edit general properties of a Menu Entry. (see "Editing a Menu or Menu Entry" on page 43) 

 
Figure 9: Menu and Menu Entry editor, General tab 

Field Descriptions 
Menu entry name - Read-only. System name for menu entry. 
Menu entry label - Required. Name displayed to users for menu entry. 
Description - Description of menu entry. 
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Accelerator - Keyboard shortcut for opening this menu entry after choosing it. The keys control, 
shift and alt are supported and can be combined with a character. The keys DELETE and INSERT 
are supported as well. Examples are: "INSERT", "control DELETE", and "alt shift X". 

Sort rank - Sort order of menu entry label when it is listed in a menu. If several menu entries have the 
same Sort rank, they are sorted alphabetically within that rank. By default, Sort rank is 1, which causes a 
menu entry label to be placed first within a menu or alphabetically among other menu entries with a Sort 
rank of 1. 

Mnemonic - Letter or character for selecting this menu entry. An accessibility feature. 

Tooltip - Brief description of the menu entry displayed when the mouse hovers over it. 

Icon path - The path, relative to the Rhythmyx root, to the graphic for the menu entry icon.  For example, 
rx_resource/images/edit.gif.  Rhythmyx displays the specified graphic beside the menu entry 

label:  . 

Options 

Support multi-select - If checked, the user can select multiple items on which to perform the menu entry's 
action.  

Refresh hint - A "hint" telling the Rhythmyx client what window(s) to refresh after executing the action 
associated with the menu entry. Options are: 

None (do not refresh any window). 
Default. 

Current (refresh only the current window)

Parent (refresh only the parent window) 

All (refresh all windows). 

Launch new window - If checked, the action associated with the menu entry launches a new window (for 
example a Content Editor is opened in a separate window instead of the Eclipse editor pane).  

Target - A name for internally referencing the new window. 

Style - Javascript options for defining the new window. The user can enter the options manually or click 
[...] to set them in the Window Style dialog (on page 28). 
 



 

28 Rhythmyx Customizing Content Explorer 
 

Window Style Dialog 
The Window Style dialog lets you create a style for the window launched when you choose a menu entry. 
The dialog is launched when you check Launch new window in the General tab of the Menu and Menu 
Entry editor and click [...] beside Style. 

 
Figure 10: Window Style dialog 

Field Definitions 
Target name - Name for internally referencing the window.   

Height - Height of the window. 

Width - Width of the window.  

Status bar - Whether or not a status bar (information bar at the bottom of the window) is included.  

Menu bar - Whether or not a menu bar is included.  

Tool bar - Whether or not a tool bar is included. Default is checked (yes). 

Scroll bars - Whether or not scroll bars are included on the sides of the window.  

Location - Whether or not a field for entering a URL is included.  

Resizable - Whether or not users can resize the window. 
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Menu and Menu Entry Editor, Usage Tab 
The Usage tab lets you specify which elements in windows accessible from Content Explorer display the 
currently edited menu or menu entry in their right-click or Menu bar menus.   

Use this tab to: 

 Add areas where the Menu or Menu Entry appears in Content Explorer. (see "Adding 
Properties to a Menu or Menu Entry" on page 41) 

 Edit areas where the Menu or Menu Entry appears in Content Explorer. (see "Editing a 
Menu or Menu Entry" on page 43) 

 
Figure 11: Menu and Menu Entry Editor, Usage tab 

Field Definitions 
Usage area -  Lists windows accessible from Content Explorer that include elements that open right-click 
or Menu bar menus. The windows are listed in the following table. For additional information including 
how to access each of these windows, see the Content Explorer online help. 
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Content Explorer Area Graphic 
 Active Assembly for Documents - 

Main Display Area 
 Active Assembly for Documents - 

Navigation Pane 

 
 Content Explorer - Main Display Area 
 Content Explorer - Navigation Pane 

 
 Impact Analyzer 

 

 Portal integrations - Portlets n/a 
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Content Explorer Area Graphic 
 Related Content Search - Main Display 

Area 
 Related Content Search - Navigation 

Pane 

 
 Site Explorer 

 

Available for UI Contexts - When a window accessible from Content Explorer is selected under Usage area, 
the Available from UI Contexts box lists the elements on that window that can include the currently edited 
menu or menu entry in their right-click or Menu bar menus.  A list of all possible elements follows. Each 
listing notes the windows from which the element is accessible. 

Category:  Available only in Content Explorer.  The menu or menu entry is available if the user has a 
category selected in the Main Display Area. 

Content Item  Available in all modes.  The menu or menu entry is available if the user has a Content 
Item selected. 

Custom Search - The menu or menu entry is available if the user has a Custom Search selected. 

Empty Search - The menu or menu entry is available if the user has a Search Results node selected. 

Field - (not currently used) 

Folder  Available only in Content Explorer.  The menu or menu entry entry is available if the user has 
a Folder selected. 

Folder Reference  Available only in Content Explorer.  The menu or menu entry entry is available if 
the user has selected Folder in search results. 

Item The menu or menu entry is available if the user has selected an item in the Impact Analyzer. 
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New Search  Available in Content Explorer, Active Assembly for Documents, and Related Content 
Search.  The menu or menu entry is available if the user has a Content Item selected in results of a 
newly-created search.. 

Parent Item  Available in Active Assembly for Documents - Navigation Pane.  The menu or menu 
entry is available if the user has the parent of the current item selected. 

Revision Available in Content Explorer - Main Display Area.  The menu or menu entry is available if 
the user has a Revision of a Content Item selected. 

Saved Search  Available in Content Explorer - Navigation Pane.  The menu or menu entry is available 
if the user has a Saved Search selected. 

Site The menu or menu entry is available if the user has a Site node selected. 

Site Subfolder The menu or menu entry is available if the user has a a Site subfolder node selected. 

Slot  Available in Active Assembly for Documents.  The menu or menu entry is available if the user 
has a Slot selected. 

Slot Item  Available in Active Assembly for Documents.  The menu or menu entry is available if the 
user has a Content Item in a Slot selected. 

Standard Search - The menu or menu entry is available if the user has a Standard Search selected. 

System Category  Available in Content Explorer - Main Display Area.  The menu or menu entry is 
available if the user has selected a category in a Display Format shipped with Rhythmyx. 

System Folder  Available in Content Explorer - Navigation Pane.  The menu or menu entry is available 
if the user has selected a Folder that shipped with Rhythmyx.   

System Site  Available in Content Explorer - Navigation Pane.  The menu or menu entry is available if 
the user has selected the default Site that ships with Rhythmyx. 

System View  Available in Content Explorer - Navigation Pane.  The menu or menu entry is available 
if the user has selected one of the default Views that ship with Rhythmyx.  These Views include 
My Content: Checked Out by Me, My Content: Inbox, My Content:  Outbox, My Content:  
Recent, My Content: Session, Community Content:  All, Other Content:  All, and Other Content. 

View  Available in Content Explorer - Navigation Pane.  The menu or menu entry is available if the 
user has selected a View. 

Show - Lists elements chosen from the Available for UI Contexts box to display the menu or menu entry in 
their right-click or Menu bar menus (for the window selected in Usage area). 
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Menu and Menu Entry Editor, Command Tab 
The Command tab specifies the command that a Menu or Menu Entry executes.   

This tab is only available for Menu Entries, which execute commands, and dynamic Menus, which 
Rhythmyx generates by running commands. The tab is not available for cascading Menus, which consist 
of Menu Entries that are manually added. 

Use this tab to: 

 Add the command associated with a Menu Entry or dynamic Menu (see "Adding Properties 
to a Menu or Menu Entry" on page 41). 

 Edit the command associated with a Menu Entry or dynamic Menu (see "Editing a Menu or 
Menu Entry" on page 43). 

 
Figure 12: Menu and Menu Entry Editor, Command Tab 
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Field Definitions 
Command Group  A category for generating a dummy value for an application that can execute certain 
commands.  For more information about the following categories of applications and the commands they 
can execute, see the section Rhythmyx HTTP Interface in the Technical Reference Guide. 

 Content Assembler - Supplies a dummy Content Assembler URL and parameters. 
 Content Editor - Supplies a dummy Content Editor URL and parameters. 
 Relationship Handler - Supplies a dummy relationship URL and parameters. 

When you reopen the Menu or Menu Entry, the Command Group always appears as Content 
Assembler, even if this does not reflect the choice you used to create your URL. 

[Generate] Click this button to generate a sample URL for the type selected in the Command Group field.  
You can modify this value if necessary.  If you have already specified a value in the URL field, the new 
value overwrites the existing value.  (The system displays a confirmation message before overwriting the 
existing value.) 

URL  The URL of the command activated by this Menu or Menu Entry.  You can specify any valid URL in 
this field. The parameter tables display any associated HTML parameters.   

Parameters  Parameters for the command specified in URL. 

Name  The name of the parameter. 

Value  The value of the parameter.  The Value can be a text string that you enter or one of the following 
system parameters available in the drop lists: 

Variable Usage Area (and elements) where available  
$sys_contentid Content Explorer 

Active Assembly for Documents (Slot on Content Item) 

Active Assembly for Documents (Item in Slot) 

$sys_revision Content Explorer 

Active Assembly for Documents (Slot on Content Item) 

Active Assembly for Documents (Item in Slot) 

$sys_contenttypeid Content Explorer 

Active Assembly for Documents (Slot on Content Item) 

Active Assembly for Documents (Item in Slot) 

$sys_tiprevision Content Explorer 

$sys_checkoutstatus Content Explorer 

Active Assembly for Documents (Item in Slot) 

$sys_contentcheckoutusername Content Explorer 

Active Assembly for Documents (Item in Slot) 

$sys_workflowid Content Explorer 
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Variable Usage Area (and elements) where available  
$sys_slotid Active Assembly for Documents (Slot on Content Item) 

Active Assembly for Documents (Item in Slot) 

$sys_slotname Active Assembly for Documents (Slot on Content Item) 

$sys_variantid Active Assembly for Documents (Item in Slot) 

$sys_relationshipid Active Assembly for Documents (Item in Slot) 

Special variables derived from the user session (Indicated by $$):   

 sys_community 
 sys_lang 
 sys_username 
 sys_mode 

The special variable $sys_folderid is also available.  It retrieves the contentid of the parent Folder of the 
selected Content Item or Folder. 
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Menu and Menu Entry Editor, Visibility Tab 
In some cases, you may use the value of a property of a Content Item or Folder to determine whether or 
not to display a Menu or Menu Entry for that Content Item or Folder.  The Visibility tab lets you specify 
these cases. 

The Visibility tab lists categories of properties for Content Items and Folders and the possible values of 
each property.  For each value of a property, the Visibility tab specifies "Show" or "Hide". If a user 
accesses a Content Item or Folder that has any "Hide" properties, the menu or menu item does not display 
for the Content Item or Folder. 

Use this tab to: 

 Add instructions for showing and hiding Menus and Menu Entries (see "Adding Properties 
to a Menu or Menu Entry" on page 41). 

 Edit instructions for showing and hiding Menus and Menu Entries (see "Editing a Menu or 
Menu Entry" on page 43). 

 
Figure 13: Menu and Menu Entry Editor, Visibility tab 
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Field Definitions 
Visibility Contexts - Categories of Content Item and Folder properties. The categories are listed in the 
following table: 

Context Definition Values 
Assignment Types The Assignment Type of the user's 

Workflow Role for the current 
Workflow State of the Content Item. 

 Admin 
 Assignee 
 None 
 Reader 

Checkout Status The user who has the Content Item 
checked out 

 Checked In (no user has the Content 
Item checked out) 

 Checked Out (a different user has the 
Content Item checked out) 

 Checked Out by Me (the user logged 
in to the system) 

Client Contexts The current condition of the Content 
Explorer 

 Drag and Drop (defines the visibility 
of the menu or menu entry in popup 
menus when a user drags a Content 
Item and drops it in a folder or Slot) 

 Multiple Selection (defines the 
visibility of the menu or menu entry 
if the user has multiple Content 
Items selected) 

 Popup Menus (defines the visibility 
of the menu or menu entry in popup 
menus displayed when the user right-
clicks in the Content Explorer) 

 Single Selection (defines the 
visibility of the menu or menu entry 
if the user has only one Content Item 
selected) 

Communities The Community of the user all Communities in the system 

Content Types The Content Type of the Content Item 
selected 

all Content Types defined in the system 
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Context Definition Values 
Folder Security The Folder Security of the user  Read  

 Write  

If you move the Read entry to Hide, users 
with Read access to a folder do not see 
menus and menu entries for that folder. 

If you move the Write entry to Hide, users 
with Read or Write access to a folder do not 
see menus and menu entries for that folder. 

NOTE: Users with Admin access to a folder 
can always see the menus and menu entries 
for the folder. 

 

Locales The Locale of the user all Locales in the system 

Object Types The type of Content Explorer object 
selected 

 Folder  
 Item  

 

Publishable   The value of the Publishable field of the 
current State of the Content Item 

 Archive (value in the Publishable 
field of the State is u) 

 Ignore (value in the Publishable field 
of the State is i) 

 Publish (value in the Publishable 
field of the State is y) 

 Unpublish (value in the Publishable 
field of the State is n) 

Roles   The Role of the user all Roles defined in the system. 

Workflow   The Workflow of the Content Item all Workflows defined in the system 

Hide - "Hide" values in the selected Visibility Context. If a Content Item or Folder has any of these values, 
the menu or menu entry does not display for the Content Item. 

Show - "Show" values in the selected Visibility Context. If a Content Item or Folder has any of these 
values, the menu or menu entry displays for the Content Item unless any other Visibility Context values 
associated with the Content Item are in a Hide list. For example, for a menu entry, if a Content Item's 
Content Type is in the Show list but its Workflow is in the Hide list, the Content Item's menus do not 
display the menu entry. By default, all Visibility Context options appear in the Show list. 
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Creating a Menu 
To create a Menu that appears in UI Elements Design View, complete the New Menu wizard. 

For a graphic of the wizard and definitions of the fields discussed below, see New Menu Wizard (on page 
19). 

To create a Menu: 

1 In UI Elements Design view, in the Menu bar, choose File > New > Other. In the Select a 
Wizard dialog, choose Menu.  

The New Menu wizard opens. 

2 In Menu name, enter an internal name for the menu. 

The Menu name is automatically entered in Label. 
3 Optionally, change the Label. 
4 Optionally, in Description, enter a description of the menu. 

5 In Menu Type, choose the way the menu options are chosen: 

 Choose Cascading menu if you will manually select Menu Entries. 

 Choose Dynamic menu if an application will select Menu Entries when the Menu is 
accessed. 

6 Click [Finish]. 

The Menu is created and appears in UI Elements Design view, but most of its properties are 
not configured, and the menu is not usable. The New Menu wizard closes and the Menu and 
Menu Entries editor (see "Menu and Menu Entry Editor" on page 23) opens. 

Now you can: 

 Configure the properties (see "Adding Properties to a Menu or Menu Entry" on page 
41) of the Menu in the Menu and Menu Entries editor. 

 Save and close the Menu and Menu Entries editor and continue configuring the Menu 
at a later time. 
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Creating a Menu Entry 
To enter the minimum amount of information to create a menu entry that appears in UI Elements View, 
complete the New Menu Entry wizard. 

For a graphic of the wizard and definitions of the fields discussed below, see New Menu Entry Wizard 
(on page 21). 

To create a Menu Entry: 

1 In UI Elements view, in the Menu bar, choose File > New > Other. In the Select a Wizard 
dialog, choose Menu Entry.  

The New Menu Entry wizard opens. 

2 In Menu entry name, enter an internal name for the menu entry. 

The Menu entry name is automatically entered in Label. 
3 Optionally, change the Label. 
4 Optionally, in Description, enter a description of the menu entry. 

5 Click [Finish]. 

The menu entry is created and appears under the User subfolder of the Menu Entries folder in 
UI Elements Design view, but most of its properties are not configured and it is not 
functional. The New Menu Entry wizard closes and the Menu and Menu Entries editor (see 
"Menu and Menu Entry Editor" on page 23) opens. 

Now you can: 

 configure the properties (see "Adding Properties to a Menu or Menu Entry" on page 
41) of the Menu Entry in the Menu and Menu Entries editor. 

 close the Menu and Menu Entries editor and continue configuring the menu entry at a 
later time. 

 drag and drop (or copy and paste) the Menu Entry onto a Menu. 
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Adding Properties to a Menu or Menu Entry 
For a graphic of the Menu and Menu Entry editor and definitions of the fields discussed below, see the 
Menu and Menu Entry Editor (on page 23) section. 

To add properties to a Menu or Menu Entry: 

1 In the Menu and Menu Entry editor, click the General tab (see "Menu and Menu Entry Editor, 
General Tab for Menus" on page 24). 

2 Optionally, change the default Sort rank. 

3 Optionally, in Mnemonic add a letter or character for selecting this menu or menu entry when 
it is visible in another menu.  

4 Optionally, in Accelerator, add a sequence of keys to serve as a shortcut for opening the menu 
or performing the function associated with the menu entry. 

5 Optionally, in Tooltip, add a definition that will appear when the user hovers the cursor over 
the menu label or menu entry label. 

6 If you want to display an icon beside the menu or menu entry label when it is listed in a menu, 
in Icon path, enter the path in the Rhythmyx root of the icon graphic file. 

7 If you are entering a menu entry (see "Menu and Menu Entry Editor, General Tab for Menu 
Entries" on page 26): 

a) Check Support multi-select if you want users to be able to perform the menu entry's 
function on a group of selected Content Items.  

b) If you want to refresh screens after Rhythmyx performs the menu entry's function, change 
the Refresh hint from the default value of None. 

c) If you want Rhythmyx to launch a new window when performing the menu entry's 
function, check Launch new window. In Target, enter a name for the window. In Style, 
enter javascript options for defining the window or click [...] to choose options in the 
Window Style dialog (on page 28). 

8 Click the Usage tab (see "Menu and Menu Entry Editor, Usage Tab" on page 29). For each 
Usage Area (Content Explorer window type) in which you want to display the currently edited 
menu or menu entry: 

a) In the Usage area box, click the usage area. 

b) For each element in the Available for UI contexts box: if you want to display the currently 
edited menu or menu entry in the element's right-click menu, move the element to the 
Show box. 

9 Click the Command tab (see "Menu and Menu Entry Editor, Command Tab" on page 33) if it 
is visible. Either: 

 Manually enter the URL of the command application that you want to execute for the 
menu entry or dynamic menu. Enter the names and values of any parameters 
associated with the application. 
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OR 

 Choose an application option in Command Group that is similar to the type of 
application that you want to use. See Menu and Menu Entry Editor, Command tab 
(on page 33), for a description of the available options. Click generate to fill in URL 
and Parameters with model entries. Modify the model entries to specify the exact 
name and values of the application and parameters that you want to use. For more 
information about the supplied options and the commands they can execute, see the 
section Rhythmyx HTTP Interface in the Technical Reference Guide. 

10 Click the Visibility tab (see "Menu and Menu Entry Editor, Visibility Tab" on page 36). By 
default, for a new Menu or Menu Entry, all values of all visibility contexts (Content Item 
properties, such as State) are in the Show list. If you do not want Content Items or Folders 
with a certain property value (such as Archived) to display the Menu or Menu Entry, click the 
Visibility context for the property, and move the value from the Show list to the Hide list. 
Repeat this procedure for all property values that should cause the Menu or Menu Entry to be 
hidden. 

11 Save and close the Menu and Menu Entry editor. 
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Editing a Menu or Menu Entry 
When you edit a Menu or Menu Entry, you can modify any of the information accessible from the Menu 
or Menu Entry editor.  

You can edit Menu and Menu Entries under the System subfolder as well as those under the User 
subfolder. 

To edit a Menu or Menu Entry: 

1 In UI Elements Design view, right-click on the Menu or Menu Entry and choose Open  

OR 

Double-click the Menu or Menu Entry. 

The Menu and Menu Entry editor (on page 23) opens with data filled in for the Menu or 
Menu Entry. 

2 In the Menu and Menu Entry editor (on page 23), on the General tab (see "Menu and Menu 
Entry Editor, General Tab for Menus" on page 24) change: 

 Menu label or Menu entry label 
 Description 

 Accelerator 
 Mnemonic 

 Tooltip 

 Sort rank  

 Icon path  

If you are editing a menu entry, you can also change: 

 the option to Support multi-select 
 the value for Refresh hint 
 the Launch new window option. If Launch new window was not previously checked, 

you must enter values for Target and Style.  See Adding Properties to a Menu or 
Menu Entry (on page 41) for information about the values to enter in these fields.  

3 In the Usage tab (see "Menu and Menu Entry Editor, Usage Tab" on page 29), change the 
Menu or Menu Entry's availability for any usage area elements by selecting the usage area and 
moving the element(s) from Available for UI contexts to Show or from Show to Available for UI 
contexts. 

4 Click the Command tab (see "Menu and Menu Entry Editor, Command Tab" on page 33) if it 
is visible. Change the URL by either: 

 Manually entering a new URL of a command application, and then entering the 
names and values of any parameters associated with the application 

OR 
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 Choosing an application option in Command group that is similar to the type of 
application that you want to use. See Menu and Menu Entry Editor, Command tab 
(on page 33), for a description of the available options. Click generate to fill in URL 
and Parameters with model entries. Modify the model entries to specify the exact 
name and values of the application and parameters that you want to use. For more 
information about the supplied options and the commands they can execute, see the 
section Rhythmyx HTTP Interface in the Technical Reference Guide. 

If you want to leave the existing URL, but change the parameters, modify the Names and 
Values in the Parameters table. 

5 Click the Visibility tab (see "Menu and Menu Entry Editor, Visibility Tab" on page 36). If you 
to change which property values of Content Items or Folders cause the Menu or Menu Entry 
to be shown or hidden, click the Visibility context for each property, and move the value from 
the Show list to the Hide list or from the Hide list to the Show list. Repeat this procedure for all 
property values whose effect on the Menu or Menu Entry's visibility you want to change.  
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Dragging and Dropping Menu Entries to 
Menus 
To move menu entries into a menu: 

1 Drag and drop (or copy and paste) a Menu Entry from the Menu Entries folder to a Menu in 
the Menus folder. You can drag and drop (or copy and paste) from either System or User 
folders. 

A reference to the Menu Entry appears under the Menu. 
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Deleting a Menu 
You cannot delete System Menus. 

To delete a user Menu: 

1 In UI Elements view, right-click on the menu and choose Delete. 

The menu is deleted.  
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Deleting a Menu Entry 
To delete a menu entry: 

1 In UI Elements view, right-click on the menu entry and choose Delete. 

The menu entry is deleted. References to the menu entry no longer appear under menus, and 
the menus no longer display the menu entries in Content Explorer. 
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Maintaining Display Formats 
Display Formats specify two different things: 

1 The columns to show in a Content Explorer user interface.  Users apply a display format to 
the contents of a folder or to the results of a View or search query to specify how they want to 
view the Content Items in the Content Explorer Display pane. 

2 The categories that organize the items included in View or Search nodes in the Content 
Explorer Navigation pane.   

For example, the following Display Format: 

 
Figure 14: Display Format Editor 

C H A P T E R  3  
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Shows View or Search categories in the Content Explorer Navigation pane by Content Type: 

 

 
Figure 15: Content Type Display Format in Navigation Pane 

And shows Columns for Content Title, Checkout Status, State, Author and Last Modified in the Display 
pane: 

 
Figure 16: Display Format in Display Pane 

Create and edit Display Formats in the Rhythmyx Workbench: 

 Use the New Display Format wizard (on page 51) to create a new Display Format. 
 Use the Display Format editor (see page 53) to complete and maintain Display Formats.  

You can: 

 Create a Display Format. (see "Creating a Display Format" on page 55) 
 Edit a Display Format. (see "Modifying a Display Format" on page 57) 
 Delete a Display Format. (see "Deleting a Display Format" on page 58) 
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New Display Format Wizard 
The Rhythmyx Workbench's Display Format wizard is used to create new Display Formats in UI Elements 
Design view. 

To access the New Display Format wizard: 

 From the Menu bar choose File > New > Other. In the Select a Wizard dialog, choose 
Display Formats.  

 In UI Elements Design view, right-click the Display Format folder and choose New > Display 
Format. 

 
Figure 17: New Display Format Wizard 

Field Descriptions 
Display Format name  The name of the Display Format.   
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Label  The label for the field displayed to the Business User, may be different from the Display Format 
Name. 

Description  A description of the Display Format. 

Available to these communities  The Communities that are available to be assigned to the Display Format.  

Visible to these communities  The communities that are able to view the Display Format. 

Filter  A term for filtering the list of Available Communities. 
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Display Format Editor 
The Display Format editor is used to maintain Display Formats.   

To access the Display Format editor: 

 After completing the New Display Format wizard, click [Finish]. 
 Right-click on the Display Format object in any view that displays it and select Open. 
 Double-click on the Display Format object in any view that displays it. 

 
Figure 18: Display Format Editor 
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Field Definitions 
Display Format name - Read only. Internal name of the Display Format. 

Label - Name of Display Format shown to users. 

Description - Description of Display Format. 

Will be used with - What areas of Content Explorer interface will use Display Format.  

 Related content searches - The Display Format can be applied to folders in related content 
searches. The Display Format can include either categories shown in the navigation pane or 
columns shown in the display pane. The sys_title (System Title) column is included by default 
and required as a column. You can move any other fields added to the Columns table to the 
Categories table. The sys_variantid and sys_contenttypeid fields are required in the Columns 
or Categories table. 

 Other searches and views - The Display Format can be applied to searches and views, but not 
folders. The Display Format can include either categories shown in the navigation pane or 
columns shown in the display pane. When a search or view is expanded in the Navigation 
pane, the categories are displayed under it. When a category is selected, its Content Items are 
displayed in the Display Pane using the columns specified. The sys_title (System Title) 
column is included by default and required as a column. You can move other fields added to 
the Columns table to the Categories table. 

 Other searches, views, and folders (no categories allowed) - The Display Format can be 
applied to the contents of searches, views and folders when they are displayed in the Content 
Explorer display pane. The Categories table is disabled. The sys_title (System Title) column is 
included by default and required. 

Sort column - Column in Columns table for sorting Content Items in display pane. 

 Ascending - Sort on Sort column in ascending order. 
 Descending - Sort on Sort column in descending order. 

Categories table - Categories to display under a search or view node in the navigation pane. 

Categories Label - Name that will appear under search or view node. 

Categories Field - Field displayed under Label. 

Columns table - Columns to list when display Content Items in the display pane. The sys_title (System 
Title) column is always included by default and required in the Columns table. The sys_title field cannot 
be moved to the Categories table.  

Columns Label - Name that will appear in column of display pane. 

Columns Field - Field displayed under column. 

Columns Width - Width of column. 

[Add Columns] - Button that opens the Field Selection editor (on page 99) for adding columns. 
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Creating a Display Format 
Use the New Display Format wizard to create a new Display Format. 

For a graphic of the wizard and definitions of the fields discussed below, see New Display Format Wizard 
(on page 51). 

To create a new Display Format: 

1 In the Menu bar, choose File > New > Other. In the Select a Wizard dialog, choose Display 
Format.  

The New Display Format wizard opens. 

2 Enter a name for the Display Format in the Display Format Name field. 
The Display Format Name is automatically entered in the Label field. 

3 Optionally, change the value in the Label field. 

4  Enter a description for the display format in the Description field.  You may want to indicate 
when and why the user should apply the display format. 

5 To specify the Communities that the new Display Format will be visible to: 

a) Select any Communities in the Visible to these communities table that you don't want to be 

able to see the Display format and click  to move them to the Available communities 
table. 

b) You can move multiple Communities by using CTRL - click and .   

c) You can move all Communities using [<<]. 

6 Click the [Finish] button. 
The New Display Format wizard closes and the Display Format editor opens. The Display 
Format appears under the Display Format folder in UI Elements Design view. 

Now you can: 

 Save and Close the Display Format editor and customize the Display Format later. You can 
use the Display Format in its default state but it will only displays the sys_title field for 
Content Items listed in the Content Explorer display pane. 

 Customize the Display Format (see "Customizing a Display Format" on page 56) in the 
Display Format editor. 

 



 

56 Rhythmyx Customizing Content Explorer 
 

Customizing a Display Format 
For graphics of the editor and definitions of the fields discussed below, see Display Format Editor (on 
page 53). 

To customize a Display Format: 

1 Select the appropriate radio button in the Will be used with section. 
When the Other searches, views, and folders radio button is selected, the Categories table is 
disabled. 

Some fields are included by default or required: 

 The sys_title field is always included by default and required in the Columns table. 
The sys_title field cannot be moved to the Categories table. 

 If you choose Related Content search in Will be used with, the sys_variantid and 
sys_contenttypeid fields are automatically added and required because a Related 
Content search required these fields to determine what content can be inserted in a 
Slot. They can be moved to the Categories table.  

 Fields can be included in the Columns table or the Categories table, but not both. 

 to create links from Content Items under one Site node in Content Explorer to Content 
Items under another Site node, you must include the sys_siteid and sys_folderid fields 
in the Display Format. 

2 To specify the fields used in the Display Format: 

a) Click the [Add Column(s)] button. 

The Field Selection editor (on page 99) opens. Use the Field Selection editor to choose 
fields for the Display Format. They appear in the Columns table. 

b) If Related Content Searches or Other searches and views is chosen under Will be used 
with, you can move fields to the Categories table. To move a field from the Columns table 
to the Categories table, select the field you want to move and click [<].   

All of the fields that you include in the Columns table appear in the drop list for Sort Column. 

3 Choose a field in Sort Column for sorting Content Items that appear in the display pane of 
Content Explorer.   

4 To sort the Content Items in the display pane by the Sort Column field in ascending order, 
choose Ascending; to sort them by descending order, choose Descending. 

5 Save and close the Display Format editor. 
Now you can: 

 Assign the Display Format to a Folder, Search or View in Content Explorer. You may have to 
refresh Content Explorer or flush the Server cache first. 
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Modifying a Display Format 
You can modify Display Format information that is accessible through the editor. 

For a graphic of the editor and definitions of the fields discussed below, see Display Format Editor (on 
page 53). 

To modify a Display Format: 

1 Change the Label or Description. 

2 You can change the Will be used with choice, but the following additional changes occur: 

 If you change from Related Content searches, a dialog warns you that it is removing 
the sys_variantid field, and gives you the option of removing the sys_contenttypeid 
column. Click [Yes] or [No] to remove the sys_contenttypeid column also. 

 If you change to Related Content searches, the sys_variantid and sys_contenttypeid 
fields are automatically added to the Columns table. 

 If you change to Other searches, views, and folders (no categories allowed) if you 
have any fields in the Categories table, a dialog will warn you that it must move the 
fields in the Categories table to the Columns table and will give you the option to 
continue. Click [Yes] or [No] to continue with the change. 

3 Click the [Add Columns] button to access the Field Selection editor (on page 99) and add any 
columns to the Columns table. 

4 Select any fields in the Columns table or Categories table and use  and  to 
change their order among the other fields. 

5 Select any fields in the Columns table or Categories table and use  and  to 
move them from one table to the other. If the move operation is not allowed, the arrow is 
disabled. You can also use [>>] to move all fields from the Categories table to the Columns 
table. 

6 Select a field and click  to remove it.  If the operation is not allowed, the button is 
disabled. 

7 Change the field in the Sort column and the option of Ascending or Descending for the sort. 

8 Save and close the editor. 
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Deleting a Display Format 
To delete a Display Format: 

1 In UI Elements Design view, right-click on the Display Format and choose Delete. 

The Display Format is deleted, and it is no longer available in Content Explorer. 
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Adding Graphics to Display Formats 
The default Display Formats provided by Percussion Software, Inc., do not include graphics, but you can 
add graphics to your custom Display Formats.   

 For details about adding static graphics (graphics not managed by Rhythmyx) to Display 
Formats, see the topic "Using Images in Display Formats (see "Using Images in Display 
Format Columns" on page 59)". 

 For details about adding thumbnail previews of Rhythmyx-managed Image Content Items, see 
the topics "Adding Thumbnail Previews to Display Formats". 

 

Using Images in Display Format Columns 
In some cases, you may prefer to use images rather than text in certain columns of your Display Format.  
For example, if your Display Format includes Locale, you might want to use images of flags to indicate 
the Locales in the Display Format rather than using text.  

You can use either .gif or .jpg files to provide these images.  You cannot use bitmaps (.bmp) as your 
image files because Java does not render bitmaps.   

If you choose to store your graphic files in your Rhythmyx installation directory, do not store them in a 
directory with “sys_” prefix.  Directories with this prefix are overwritten on upgrade, and your graphics 
will be lost.  A good option is to store your graphic files in the rx_resources\images directory.  Since this 
directory has an “rx_” prefix, it will not be overwritten on upgrade and you will not lose your graphics. 

To render a Display Format column as an image: 

1 If the field does not already exist, add it to a Content Editor Definition. 

Often when you want to use an image, you need to use a computed field rather than a field 
bound to a backend database column.  A computed field uses a UDF (specified in the 
PSXExtensionCall node) to generate the value of the column.  The computed value might be a 
single word or it might be the URL of the location of the graphic file.  If you define a 
computed field, be sure you specify Image as the <DataType> of the field. 

2 Add an XSLT template to the file 
<rxroot>\rx_config\rx_DisplayFieldTemplates.xsl to override or modify 
the value of the field computed by the Content Editor.  For details, see the comments in the 
file rx_DisplayFieldTemplates.xsl.  

For example, the following template substitutes images for the text of Checkout Status: 
<xsl:template match="ResultField[@name='sys_locale']" 
mode="rc_res_displayfield"> 
  <xsl:param name="sys_contentid"/> 
  <xsl:param name="sys_revision"/> 
  <xsl:param name="sys_contenttypeid"/> 
  <xsl:param name="sys_variantid"/> 
  <ResultField name="{@name}"> 
   <xsl:choose> 
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    <xsl:when test="(.='en-
us')">../rx_resources/images/usflag.gif</xsl:when> 
    <xsl:when test="(.='en-uk')">../ 
rx_resources/images/ukflag.gif </xsl:when> 
    <xsl:when test="(.='fr-
fr')">../sys_resources/images/frtricolor.gif</xsl:when> 
    <xsl:when test="(.='fr-
ca')">../sys_resources/images/quebec.gif</xsl:when> 
   </xsl:choose> 
  </ResultField> 
 </xsl:template> 

Modify the field if the Content Editor itself does not include enough to compute the field.  For 
example, suppose you want to render a thumbnail in a Display Format for Related Content 
Search results.  To render the correct image, you would need the Variant ID that assembles 
the thumbnail image.  You would first use a UDF to compute the value of the field, then 
modify it in the XSLT template to retrieve the correct image.  If you do not override the 
template, Rhythmyx will display the value computed by the UDF rather than the thumbnail 
image.   

3 Add the field to the Display Format, or create a Display Format that includes it.  
 

Adding Thumbnail Previews to Display Formats 
To add a thumbnail preview of an Image Content Item to a Display Format: 

1 Add a new entry to the file <Rhythmyxroot>/rxconfig/server/addThumbnailURL.properties 
for each image Content Type, mapping the Content Type ID to the ID of the thumbnail 
Variant you want to use to preview the Content Type in the Display Format.  For example, if 
you had a Content Type with an ID of 350, and you wanted to use a Variant with an ID of 324 
to preview it in Display Formats, you would add the following entry to the 
addThumbnailURL.properties file: 

350=324 

Note that only one mapping per Content Type is supported.  If the file contains more than one 
entry for a Content Type ID, only the last entry will be used. 

2 Add the column sys_thumbnail to the Display Format. 
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Maintaining Searches 
Searches are queries for locating certain Content Items in Content Explorer or during Active 
Assembly.You can predefine any number of searches for end users to use. For example, you could create a 
search that queries on creation date and another search that queries on Content Type. 

You can specify that a search is user-customizable, or allows a user to change the query options.   

You also must specify a default Search that opens when a user chooses New Search in Content Explorer, 
and a default Search that opens when a user chooses Search during Active Assembly or Active Assembly 
for Documents. 

The Search editor that Rhythmyx shows you depends on the search engine that your system uses. The 
search engines available are the Full-text Search engine and the database search engine.  

For more information about the way end users search, see the Content Explorer Online Help. 

You create and edit searches in the Rhythmyx Workbench: 

 Use the New Search wizard (on page 62) to create a new search. 
 Use the Search editor to maintain standard searches (see "Search Editor, Standard Search" 

on page 64). 
 Use the Search editor to maintain custom searches (see "Search Editor, Custom Search" on 

page 71). 
 Use the Default Dialogs for New Searches screen to specify the default searches that open in 

Content Explorer and Active Assembly. 

You can: 

 Create a simple search (see "Creating a Search" on page 74) 
 Customize a standard search (on page 75) 
 Customize a custom search (see "Configure a Custom Search" on page 76) 
 Modify a standard search (on page 78) 
 Modify a custom search (on page 79) 
 Specify the default searches that open in Content Explorer and during Active Assembly (see 

"Setting New Searches for Communities" on page 80) 
 Delete searches (see "Deleting a Search" on page 81) 
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New Search Wizard 
The New Search wizard allows you to create new searches that appear in UI Elements Design view under 
the Searches folder.   

To access the New Search wizard: 

 From the Menu bar choose File > New > Other. In the Select a wizard dialog, choose Search. 
 In UI Elements view, right-click on the Search folder or one of the Search subfolders and 

choose New > Search. 

 
Figure 19: New Search wizard 

Field Definitions 
Search name - Required. System name for search query. 
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Label - Required. Name displayed to users for search query. 

Description - Description of search. 

Type - Standard or Custom. A standard search query is created using the fields provided in the interface; a 
custom search query uses a separate application. 

Available Communities - Communities that may have access to the search. 

Visible to these Communities - Communities that do have access to the search. 

Filter - Pattern for choosing Communities to display in Available Communities 
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Search Editor, Standard Search 
The Search Editor for standard searches lets you customize a standard search.  

To access the Search Editor for standard searches: 

 After completing the New Search wizard (on page 62) (and selecting the Type Standard), 
click [Finish]. 

 Right-click on the standard search object in any view that displays it and select Open. 
 Double-click the standard search object in any view that displays it. 

Using the Search Editor for standard searches you can: 

 Customize a standard search (on page 75) 
 Modify a standard search (on page 78) 

Depending on the search engine that your system uses, you will either see: 

 the Standard Database Search Editor (see "Standard Database Search Editor" on page 65) or; 
 the Standard Full Text Search Editor (see "Standard Full Text Search Editor" on page 68) 
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Standard Database Search Editor 
The standard search editor for systems that use the database engine appears as follows: 

 
Figure 20: Standard Search dialog 

Field Definitions 
Standard Search Name - Read only. System name for search query. 

Standard Search Label - Required. Name displayed to users for search query. 

Description - Description of search. 

Maximum rows returned   Specifies the maximum number of results to return for the query.  Default is -1. 
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Unlimited  Check this box to return all results of the query.  If this value is checked, Rhythmyx ignores the 
value in the Maximum Results field. 

Display Format  Specifies the display format (see "Maintaining Display Formats" on page 49) used for the 
View.  Options are all display formats currently available in the system.  The default is the first display 
format in alphabetical order. 

Initial display mode - Simple or Advanced.  

 In Simple display mode, the following fields are included on the search dialog by 
default: 

o Title 

o Content ID 

o Community 

o Content Type 

o Created By 

The dialog also includes the Display Format and Max rows returned fields. An [Advanced] 
button is also available for moving to Advanced mode. 

 
Figure 21: Database Search Engine dialog 
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 Advanced display mode displays the same fields as those displayed in the Search 
editor graphic, above (other than Description, Initial display mode, and User 
customizable). A [Simple] button is available for moving to Simple mode. 

User customizable - When checked, the search dialog displays a [Customize] button that users can click to 
open the Field Selection editor (on page 99), which enables them to add or remove fields to the search 
query. 

Search Criteria - The contents of this box vary, depending on the fields you specify for the View.  Use the 
[Customize] button to maintain the fields included in the search.  The control for the field varies depending 
on the data type of the field. 

Title - A drop list of options and a text box for filling in the Title or a portion of the Title to search for. The 
options in the drop list are Starts with, Contains, Ends with, Exact. 

 Starts with - The title must start with the value entered in the text box. 
 Contains - The title must contain the value entered in the text box. 
 Ends with - The title must end with the value entered in the text box. 
 Exact - The title must match the value entered in the text box. 

Title is the default Search Criteria field.  As the definition for Search Criteria Explains, you can add 
other search criteria fields. 

[Customize] - Opens the Field Selection editor (on page 99), which enables users to add or remove fields 
to the search query. 
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Standard Full Text Search Editor 
The standard search editor for systems that use the Full Text Search engine appears as follows: 

 
Figure 22: Search Editor, standard searches 

Field Definitions 
Standard Search Name - Read only. System name for search query. 

Standard Search Label - Required. Name displayed to users for search query. 

Description - Description of search. 

Search for - Word or words or word fragment you want to search for. There is a limit of 100 characters in 
this field.  

Mode - How the search engine conducts the search. 

 Concept - A Concept search finds words that have meanings related to the term you 
enter.  For example, if you entered the word “cat”, a Concept search may also return 
Content Items that include the words “lion” and “tiger” as well.   
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 Pattern - A Pattern search finds Content Items that includes words that match the 
word you entered closely, but not exactly.  For example, if you entered the word 
“cat”, a Pattern search would also return Content Items that include the words 
“catalog” and “catamaran” as well.   

 Boolean - A Boolean search is a search that finds an exact match for your query using 
Boolean operators.   

Filter with - Specific word or words that the items found must include. 

Expansion - If you are using Concept Mode, specify the Expansion, which determines how closely or 
distantly related a word must be to the word you entered.  Rhythmyx allows the following levels of 
Expansion (examples assume that you entered the word “catch” in the Search for field): 

 exact matches (returns only Content Items that include the word “catch” or nearly 
identical variants, such as “catches”); 

 simple variations (In addition to the previous option, also returns Content Items that 
include the word “caught”); 

 most strongly related concepts (default option; in addition to the previous option, also 
returns Content Items that include the word “catchable” and “catching”); 

 strongly related concepts (In addition to the previous option, also returns Content 
Items that include words such as “bag” or “arrest”); 

 weakly related concepts (In addition to the previous option, also returns Content 
Items that include words such as “capture”, “secure”, “seize”, or “nail”. 

Max rows returned - Maximum number of results to return. 

Unlimited - Return all results. If checked, any value in Max rows returned is ignored. 

Display Format - The Display Format (see "Maintaining Display Formats" on page 49) you want to use to 
display the results of the search. 

Initial display mode - Simple or Advanced.  

 In Simple display mode, only the Search for, Display Format, and Max rows returned 
fields are visible in the dialog. An [Advanced] button is also available for moving to 
Advanced mode. 

 
Figure 23: Full Text Search Engine dialog 
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 Advanced display mode displays the same fields as those displayed in the Search 
editor graphic, above (other than Description, Initial display mode, and User 
customizable). A [Simple] button is available for moving to Simple mode. 

User customizable - When checked, the search dialog displays a [Customize] button that users can click to 
open the Field Selection editor (on page 99), which enables them to add or remove fields to the search 
query. 

Search Criteria - The contents of this box vary, depending on the fields you specify for the View.  Use the 
[Customize] button to maintain the fields included in the search.  The control for the field varies depending 
on the datatype of the field. 

Title - A drop list of options and a text box for filling in the Title or a portion of the Title to search for. The 
options in the drop list are Starts with, Contains, Ends with, Exact. 

 Starts with - The title must start with the value entered in the text box. 
 Contains - The title must contain the value entered in the text box. 
 Ends with - The title must end with the value entered in the text box. 
 Exact - The title must match the value entered in the text box. 

Title is the default Search Criteria field.  As the definition for Search Criteria Explains, you can add 
other search criteria fields. 

[Customize] - Opens the Field Selection editor (on page 99), which enables users to add or remove fields 
to the search query. 
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Search Editor, Custom Search 
The Search Editor for custom searches lets you complete or edit a custom search. 

To access the Search Editor for custom searches: 

 After completing the New Search wizard (on page 62) (and selecting the Type Custom), click 
[Finish]. 

 Right-click on the custom search object in any view that displays it and select Open. 
 Double-click the custom search object in any view that displays it. 

Using the Search Editor for custom searches you can: 

 Complete a custom search (see "Configure a Custom Search" on page 76) 
 Modify a custom search (on page 79) 

 
Figure 24: Search Editor, custom searches 
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Field Definitions 
Custom Search Name - Read-only. System name for search query. 

Custom Search Label - Required. Name displayed to users for search query. 

Description - Description of search. 

Custom Search URL - URL of application that includes the custom search query. 

Max rows returned - Maximum number of results to return. 

Unlimited - Return all results. If checked, any value in Max rows returned is ignored. 

Display Format - The Display Format (see "Maintaining Display Formats" on page 49) you want to use to 
display the results of the search. 

Search Criteria - The contents of this box vary, depending on whether or not you specify fields for this 
view, and which fields you specify. Use the [Customize] button to include Content Type fields in the 
search.  The control for the field varies depending on the data type of the field. 
drop list - options describing how the entry in Title must match the Content Item title. Options are Starts 
With, Contains, Ends With, Exact. 

Starts With - The Content Item title must start with the value. 

Contains - The Content Item title must start with the value. 

Ends With - The Content Item title must end with the value. 

Exact - The Title of the Content Item must match the entered string exactly. 
Title - exact title or part of title to search for. 

[Customize] - Opens the Field Selection editor (on page 99) for further customizing the search. 
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Configuring Community Searches 
You can configure the pre-defined search each Community uses both for new searches in general and for 
Active Assembly.  Use the Configure New Searches for Communities dialog to configure the searches for 
Communities.  To access the Configure New Searches for Communities dialog, on the Content View and 
Search Editor, click the [Community New Searches] button. 

 
Figure 25: Configure New Searches for Communities dialog 

Field Descriptions 
New CX Search  Drop list.  Specifies the pre-defined search used by default Content Explorer when a user 
initiates a new search.  Options include all pre-defined searches in the system. Rhythmyx provides you 
with the basic, user-customizable Default CX New Search. 

New AA Search  Drop list.  Specifies the pre-defined search used by default when a user searches for 
related content for Active Assembly.  Options include all pre-defined searches in the system. Rhythmyx 
provides you with the basic, user-customizable Default AA New Search. 

Community Specific Searches  Table.  For each Community in the system, you can specify a New Content 
Explorer Search and a new Active Assembly search.  The cells for New CX Search and New AA Search 
are drop lists with all pre-defined searches in the system as options.    To specify a search for a 
community, select it from the drop list. 
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Creating a Search 
To create a simple search that appears in UI Elements Design View, complete the New Search wizard. 

For a graphic of the wizard and definitions of the fields discussed below, see New Search Wizard (on 
page 62). 

To create a new Search: 

1 In the Menu bar, choose File > New > Other. In the Select a Wizard dialog, choose Search.  

The New Search wizard opens. 

2 In Search name enter an internal name for the search. 

The Search name is automatically entered in Label. 
3 Optionally, change the value in Label.  
4 Optionally, in Description, enter a description of the search. 

5 In Type, enter Standard if you want to use the Search editor to create a search query. Enter 
Custom if you want to point to an application that performs the search query. 

6 Move any Communities that you do not want to be able to view the search from Visible to 
these Communities to Available to the Communities.  

7 To reduce the number of Communities displayed in Available Communities, enter a matching 
term in Filter. 

8 Click [Finish]. 

The Search is created and appears in UI Elements Design view under the Standard or Custom 
Search folder depending on the Type of search you have specified. The New Search wizard 
closes. If you have specified that the search Type is Standard, the Search Editor for standard 
searches (see "Search Editor, Standard Search" on page 64) opens. If you have specified that 
the search Type is Custom, the Search Editor for custom searches (see "Search Editor, 
Custom Search" on page 71) opens. 

Now you can: 

 customize the standard search (see "Customize a Standard Search" on page 75) or configure 
the custom search (see "Configure a Custom Search" on page 76) 

 Drag and drop (or copy and paste) searches under Communities in the Community Visibility 
view (see "Community Visibility" on page 8) 
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Customize a Standard Search 
For graphics of the editors and definitions of the fields discussed below, see Standard Database Search 
Editor (on page 65) and Standard Full Text Search Editor (on page 68). 

To customize a standard search: 

1 Either check Unlimited or enter a maximum number of search results to return in Max rows 
returned. 

2 In Display Format, choose the Display Format for displaying the search results. 

3 In Initial display mode, choose Simple or Advanced. 

4 Check User customizable if you want users to be able to customize the fields that appear for 
use in the search query. 

5 In the Search Criteria Title drop list, choose the matching criteria for Title. 

6 Optionally, enter a string in Title to search on. 

7 To make additional fields available to the search query, click [Customize] and customize the 
fields available for the search query (see "Selecting Fields used in Display Formats, Views, 
and Searches" on page 101).  

If your system uses the Full Text Search engine, you can also customize the following fields: 

1 In Search for, enter a word or word fragment or group of words to search for. 

2 In Mode, choose a search mode: 

 choose Concept to find items with words that match the meaning of your search 
terms;  

 choose Pattern to find items with words that include the characters that you enter;  

 choose Boolean to find items with words that meet an operation you specify with 
Boolean operators (for example, date > 20050101). 

3 In Filter with, enter characters that text in the item must contain. 

4 If you are using Concept Mode, in Expansion specify the degree to which the word or 
characters in the item must match your search terms.  

5 Save and close the editor. 
Now you can: 

 Drag and drop (or copy and paste) (see "Dragging and Dropping Menu Entries to Menus" on 
page 45) the search under Communities in the Community Visibility view (see "Community 
Visibility" on page 8). 

 Designate the search as one of the system's default searches (see "Setting New Searches for 
Communities" on page 80). 
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Configure a Custom Search 
For a graphic of the Search editor for custom searches and definitions of the fields discussed below, see 
Search Editor, Custom Search (on page 71). 

To configure a custom search: 

1 In Custom Search URL, enter the address of the application that contains the search query. 

2 Either check Unlimited or enter a maximum number of search results to return in Max rows 
returned. 

3 In Display Format, choose the Display Format for displaying the search results. 

4 In the Search Criteria Title drop list, choose the matching criteria for Title. 

5 Optionally, enter a string in Title to search on. 

6 To make additional fields available to the search query, click [Customize] and customize the 
fields available for the search query (see "Selecting Fields used in Display Formats, Views, 
and Searches" on page 101).  

7 Save and close the editor. 
Now you can: 

 Drag and drop (or copy and paste) (see "Dragging and Dropping Menu Entries to Menus" on 
page 45) the search under Communities in the Community Visibility view (see "Community 
Visibility" on page 8). 

 Set the search as one of the system's default searches (see "Setting New Searches for 
Communities" on page 80). 

 

Building a Custom Search Application 
Custom Search applications are based on the Results.dtd.  The incoming request requires pre-processing.    

Content Explorer converts the data from the user requests into HTML parameters.  It collects these 
parameters into an XML document, based on the following DTD: 

<!ELEMENT HtmlParams ANY> 
The root element of this document contains one of more child elements as name-value pairs.  The name of 
each element is the name of the parameter and the value of the element is the value of the parameter.  The 
document can contain multiple elements with the same name to support parameter with multiple values. 

When a user enters a value in a search field, the name of the field is used as the name of the HTML 
parameter.  For example:  <sys_title>xyz</sys_title>. 
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The name of the HTML parameter that stores the operator is <fieldname>_parameter.  The value 
of the operator depends on the data type of the field and an operator specified by the end user.  Content 
Explorer may submit the following operator values: 

Data Type of Field Operator Selected 
by User 

Submitted value Additional 
processing of the 
value parameter 

Keyword Any in  

Starts with like “%” appended to end of 
the value parameter 

Contains like “%” appended to both 
beginning and end of 
the value parameter 

Ends with like “%” appended to the 
beginning of the value 
parameter 

Text 

Exact equal  

Equals equal  

Greater Than greaterThan  

Less than lessThan  

Numeric 

 

Between between Value parameter sent as 
a list of two values. 

On equal  

Before lessThan  

After greaterThan  

Date 

 

Between between Value parameter sent as 
a list of two values. 

The incoming XML document will include a parameter for each field defined on the Search Query tab of 
the Search Editor, and an associated operator parameter.  The document must be parsed into your resource 
query.  A utility pre-exit, sys_ExtractHtmlParamsFromInputDoc, is included with Rhythmyx that should 
suit your purposes; if you need more complicated processing, you may need to write your own exit. 

The SQL required by your database may require a different syntax than the operator value submitted by 
Content Explorer.  If this is the case, you will need to develop another pre-exit that converts the operator 
values submitted by Content Explorer into the SQL syntax required by your RDBMS.  The exact nature of 
these exits depends on the nature of the search queries you expect from your users and the requirements of 
your RDBMS.  The sys_ConvertCustomSearchOperator exit included with Rhythmyx should be suitable 
for most queries and supports all of the data types listed in the table above.  

When creating the custom search application, follow the procedure described for developing a custom 
View application.  In addition, add the sys_ExtractHtmlParamsFromInputDoc pre-exit, the 
sys_ConvertCusomtSearchOperator pre-exit, or any other custom pre-exits you define the parse the 
incoming search query XML document. 
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Modify a Standard Search 
You can modify any of the information for a standard search accessible through the Search Editor for 
standard searches. 

For graphics of the editors and definitions of the fields discussed below, see Standard Database Search 
Editor (on page 65) and Standard Full Text Search Editor (on page 68). 

To modify a standard search: 

1 Change any of the following: 

Standard Search label  
Description 

Display Format  
Initial display mode 
User customizable 

Add, remove, or change the value entered  Title, or click [Customize] to add or remove 
custom fields (see "Field Selection Editor" on page 99) that you have included under Search 
criteria. 

2 If your system uses the Full Text Search engine, you can also change the values of the 
following fields: 

Search for 
Mode. If you change the Mode to Concept, choose an Expansion value. If you change the Mode 
from Concept, the Expansion field is no longer used. 

Filter with 

Check or uncheck Unlimited or change the maximum results returned in Max rows returned. 

3 Save and close the editor. 
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Modify a Custom Search 
You can modify any of the information for a standard search accessible through the Search Editor for 
standard searches. 

For a graphic of the editor and definitions of the fields discussed below, see Search Editor, Custom 
Search (on page 71). 

To modify a custom search, change any of the following: 

1 Custom Search label  
Description 
Display Format  
Check or uncheck Unlimited or change the maximum results returned in Max rows returned. 

Click [Customize] to add or remove custom fields (see "Field Selection Editor" on page 99) 
that you have included under Search criteria.  

2 If you have changed the location of the URL of the application that performs the query, or you 
want to use a different query, change the value in Custom search URL. 

3 Save and close the editor. 
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Setting New Searches for Communities 
For graphics of the editors and definitions of the fields discussed below, see the Configure New Searches 
for Communities Dialog. 

To set default new searches in general and for Communities: 

1 In UI Elements Design view, right-click the Searches folder and choose Assign New Searches 
by Community. 

2 In New CX Search choose a search in the drop list. This search will open when users double-
click the New Search node in the navigation pane of Content Explorer. 

3 In New AA Search choose a search in the drop list. This search will open when users choose to 
search for a related content item during Active Assembly or Active Assembly for documents. 

4 If you want to use different default searches for any of the Communities in your system, in the 
Community Specific Searches table, in the row for the Community choose a different New CX 
Search or New AA Search. 

5 Save and close the editor. 
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Deleting a Search 
To delete a Search: 

1 In UI Elements Design view, right-click on the search and choose Delete. 
The search is deleted, and it is no longer available in Content Explorer. 
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Maintaining Content Explorer 
Views 
A View is a pre-defined query that helps arrange content in Content Explorer. Business Users can define 
their own searches, but Views are predefined for them.   

Rhythmyx provides a set of default Views: 

 
Figure 26: The Default Rhythmyx Views 

Implementers can also define Views. Views provide implementers with the ability to apply more complex 
queries than those available using a simple search mechanism.  The Inbox View that is included with 
Rhythmyx by default is an example of this type of View, which displays content that is assigned to a user's 
Role.  It requires a query of content in States associated with the user's Role, which is beyond the 
capability of a search query.   

Create and edit Views in the Rhythmyx Workbench: 

 Use the New View wizard (on page 84) to create a new View. 
 Use the View editor (on page 86) to complete and maintain Views. 

You can: 

 Create a View (see "Creating a New Content Explorer View" on page 89) 
 Customize a standard View (see "Configuring a Standard Content Explorer View" on page 

91) 
 Customize a custom View (see "Configuring a Custom Content Explorer View" on page 92) 
 Edit a View (see "Modifying a Standard View" on page 96) 
 Delete a View (see "Deleting a Content Explorer View" on page 98) 
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New View Wizard 
The New View wizard is used to create Content Explorer Views that appear in UI Elements Design view 
under the Views folder. 

To access the New View wizard; 

 From the Menu bar choose File > New > Other. In the Select a Wizard dialog, choose View.  
 In UI Elements Design view, right-click the Views folder or one of its subfolders and choose 

New > View. 

 
Figure 27: New View Wizard 

Field Definitions 
View Name - Required. System name for the view. 
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Label - Required. View name displayed to end users. 

Description - Description of the view. 

Type - Specifies the type of view. There are two choices available in the dropdown menu, Standard 
(manually entered query) or Url (address of application that generates the View). 

Parent Category - Specifies the parent category in which the View or search is listed.  The drop list 
contains the following Rhythmyx-supplied options: All Content, Community Content, My Content, and 
Other Content.  

Available Communities - Communities that are available to be assigned to the View. 

Visible to these communities - Communities that are able to see the View. 

Filter - Filters the list of Available Communities. 
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View Editor 
The View Editor lets you complete or edit a View.  

To access the View Editor: 

 After completing the New View wizard (on page 84) click [Finish]. 
 Right-click on the View object in any view that displays it and select Open. 
 Double-click the View object in any view that displays it. 

Depending on the Type of View you have chosen in the New View wizard, you will either see: 

 The Standard View editor (see "Standard View Editor" on page 86) 
 The Custom View editor (see "Custom View Editor" on page 87) 

 

Standard View Editor 
The View editor for standard Views lets you customize a standard View. 

To access the standard View editor: 

 When completing the New View Wizard (on page 84), choose Standard as the value for the 
Type drop list, complete the rest of the wizard, then click the Finish button. 

 Right-click on the standard View object in any view that displays it and select Open. 
 Double-click the standard View object in any view that displays it. 

Using the View editor for standard Views, you can: 

 Configure and customize a standard View (see "Configuring a Standard Content Explorer 
View" on page 91) 

 Modify a standard View (see "Modifying a Standard View" on page 96) 

Depending on the search engine that your system uses, you will either see 

 the Standard Database View Editor; or 
 the Standard Full-text View Editor 
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Custom View Editor 
The Custom View Editor will open if the View was defined as Url in the New View Wizard. 

 
Figure 28: Custom View Editor 

Field Definitions 
Custom View name - Read only. The name used for the View in the Rhythmyx server.   

Custom View label - This field is required.  The label displayed in the user interface for the View.  It must 
be unique among all defined Views.  This value is available for translation in globalized environments. 

Description - This field is optional.  Free form description of the View.  

Display Format - Specifies the display format to be used for the View.  It lists all display formats currently 
available in the system in alphabetical order. The default selection is the first display format in the list. 
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Parent Category - Specifies the parent category in which the View or search is listed.  The drop list 
contains the following Rhythmyx-supplied options: All Content, Community Content, My Content, and 
Other Content.  

Custom View URL - This field is required.  Specifies the path, relative to the Rhythmyx root, to the 
Rhythmyx application and resource that retrieves content for the View. 

Parameters - Specifies custom properties for the application and resource that create the View.  

Name column - Property names. 

Value column - Property values. 
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Creating a New Content Explorer View 
To create a new Content Explorer View that appears in UI Elements Design view, complete the 
information in the New View Wizard. 

For a graphic of the Wizard and definitions of the fields discussed below, see New View Wizard (on page 
84). 

To create a Content Explorer View: 

1 In the Menu bar, choose File > New > Other. In the Select a Wizard dialog, choose View. 

The New View Wizard opens. 

2 In the View name field, enter an internal name for the view. 

The View name is automatically entered in Label. 
3 Optionally, change the value in Label.  
4 Optionally, in the Description field, enter a description of the view. 

5 In the Type drop down list, select the view type: 

 Select Standard to create a query view using the View Editor. 

 Select Url to specify a path, relative to the Rhythmyx root, to the Rhythmyx 
application and resource that generates the view. 

6 In Parent Category, choose a Rhythmyx view parent category. Choices are My Content, 
Community Content, All Content, and Other Content. The new view will appear in Content 
Explorer under the Parent view that you choose. 

7 Move any Communities that you do not want to be able to see the view from Visible to these 
Communities to Available to the Communities.  

8 To reduce the number of Communities displayed in Available Communities, enter a matching 
term in Filter. 

9 Click [Finish]. 

The View is created and appears in UI Elements Design view under the Standard or Custom 
Search folder depending on the Type of search you have specified. The New Search wizard 
closes. If you have specified that the search Type is Standard, the Search Editor for standard 
searches (see "Search Editor, Standard Search" on page 64) opens. If you have specified that 
the search Type is Custom, the Search Editor for custom searches (see "Search Editor, 
Custom Search" on page 71) opens. 

10 Click [Finish]. 

The View is created and can be found on the UI Elements Design view under the Standard or 
Custom sub-folder of the Views folder. Most of the Views properties are not configured and it 
is not functional. The New View wizard closes and the either the Standard View Editor (see 
"Configuring a Standard Content Explorer View" on page 91) or the Custom View Editor (see 
"Configuring a Custom Content Explorer View" on page 92) opens, depending on the Type 
selection you made in the within the New View wizard.  
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Now you can: 

 Configure the properties of the view in the View Editor (on page 86). 

 Save and close the View Editor and continue configuring the view at a later time. 
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Configuring a Standard Content Explorer 
View 
For instructions on how to access the Standard View Editor, a graphic and definitions of the fields 
discussed below, see Standard View Editor (on page 86). 

To configure a standard view: 

1 Open the view you wish to customize. 

2 In Display Format, select the Display Format to be used for displaying the search results. 

3 In the Max rows returned field, enter a number of items to display or to display all results, 
check the Unlimited box. 

4 In the Search Criteria section, click [Customize] to open the Field Selection editor (on page 
99) to choose fields for creating a view query.   

5 Enter values for the fields entered in Search Criteria to create the query for selecting Content 
Items. 

6 Save and close the Standard View editor. 
Now you can: 

 Use the View in Content Explorer. You may have to refresh Content Explorer or flush the 
Server cache before it appears. 
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Configuring a Custom Content Explorer 
View 
For instructions on how to access the Custom View Editor, a graphic and definitions of the fields 
discussed below, see Custom View Editor (on page 87). 

To customize a custom view: 

1 Open the view you wish to customize. 

2 In Display Format, select the Display Format to be used for displaying the search results. 

3 In the Custom View URL field specify the path to the Rhythmyx application and resource that 
retrieves content for the view. 

4 In the Parameters section specify parameters for the application and resource. Enter the name 
of the parameter in the Name column and the value of the parameter in the Value column. 

5 Save and close the Standard View editor. 
Now you can: 

 Use the View in Content Explorer. You may have to refresh Content Explorer or flush the 
Server cache before it appears. 

 Click [Finish] to save the view. 
 

Building a Custom View Application 
Custom View application resources are based on the Result.dtd.  To build a custom View application: 

1 In the Rhythmyx Workbench, start a new application (in the Menu bar, choose Application > 
New). 

2 On the Files tab of the Rhythmyx Workbench, browse to the sys_cxViews application folder, 
and drag and drop the Results.dtd into you application.  Choose Query from the pop-up menu. 

3 Rhythmyx creates a resource with the name Result, linked to the Default XSL stylesheet. 

4 Double-click on the Result resource to open the Mapper. 

5 Choose the data tab for the database where your tables are stored, and open the database 
where your content tables are stored.  Drag and drop the tables needed for your query to the 
datatank end of the datapipe. 
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6 Map the database tables to the query.  The following graphic shows the mapping of the Inbox 
view resource in the sys_cxView application (see this application in the Rhythmyx 
Workbench for the parameters and other details of the UDFs): 

 
Figure 29: Mappings of the Inbox View resource 

7 Double-click on the Selector to open it.  In the Selector, click the Manually enter SQL radio 
button and enter your SQL query in the SELECT statement field. 

8 Optionally, add a Pager. 

a) On the Workbench Menu bar, choose Insert > Result Pager.   
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b) Rhythmyx displays the Result Pager dialog. 

 
c) Specify the Max rows per page, Max pages, and Max displayed links per page. 

d) To specify Sorting criteria, click the New button  on the Results Pager dialog, and 
choose the column you want to use when sorting results.  By default, all columns are 
sorted in ascending order.  If you want to sort in descending order, uncheck the Ascending 
checkbox in the row you want to sort in descending order.  You can specify multiple sort 
criteria.  Rhythmyx sorts results based on the order of the sort criteria (in other words, all 
results are sorted based on the first column specified, then the results within that order are 
sorted based on the second column specified, and so on).  To modify the order of the sort 
criteria, select a row you want to move and click the up or down arrows to change its 
position. 

e) Click [OK] to close the Result Pager.   

9 Close the Mapper. 

10 Right-click on the request icon and choose Request Properties.  In the Request Name field of 
the Request Properties dialog, specify a new name for the query resource. 

11 Click the [Copy to Clipboard] button, then click [OK] to close the Request Properties dialog. 

12 Save and start the application. 

13 Assign the new application to a View or search: 

a) In the Workbench, choose the Server Objects tab. 

b) Start the Content View Editor. 
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c) Open the Content View for which you created the application.   

d) If you have not already created a View, create it now using the procedure in "Creating a 
View".  Add the new View to the Custom node. 

e) On the URL tab of the View, specify the name of the Rhythmyx application you created. 

14 On the URL tab of the Content View Editor, click in the URL field and paste the URL you 
copied to the clipboard from the Request Properties dialog for the View query. 

15 Save the View. 
Start Content Explorer (or refresh it if you have already started it), and test the new View. 
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Modifying a Standard View 
You can modify any of the information for a standard view accessible through the Standard View editor. 

For a graphic of the View Editor, instructions on opening it, and definitions of the fields discussed below, 
see the Standard View Editor (on page 86).  

To edit a standard view: 

1 In the Standard View Editor (on page 86), you may modify: 

 Standard View label 
 Display Format 
 Description 

 Search Criteria Fields and their values 

 Max Rows Returned/Unlimited 

2 Save and close the editor. 
Now you can: 

 In the Community Visibility view (see "Community Visibility" on page 8), change the 
Communities that use the View. 
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Modifying a Custom View 
You can modify any of the information for a custom view accessible through the Custom View editor. 

For a graphic of the View Editor, instructions on opening it, and definitions of the fields discussed below, 
see Custom View Editor (on page 87). 

To edit a custom view: 

1 In the Custom View Editor (on page 87), you may modify: 

 Custom View label 
 Display Format 
 Description 

 Custom View URL. If you change the URL to point to another application and 
resource, you may have to change the Names and Values of Parameters for the new 
application. 

 If you do not change the Custom View URL, you can change the Names and Values of 
the Parameters associated with it. 

2 Save and close the editor. 
Now you can: 

 In the Community Visibility view (see "Community Visibility" on page 8), change the 
Communities that use the View. 
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Deleting a Content Explorer View 
To delete a View: 

1 In UI Elements Design view, right-click on the View and choose Delete. 
The View is deleted, and it is no longer available in Content Explorer.  
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Field Selection Editor 
Use the Field Selection Editor to manage the fields included in display formats, standard Views, and 
standard and custom Searches. 

To access the Field Selection Editor, in the Display Format editor (see page 53), Standard View Editor 
(see page 86), Standard Search Editor (see "Search Editor, Standard Search" on page 64), or Custom 
Search Editor (see "Search Editor, Custom Search" on page 71), click [Add Columns] or [Customize]. 

 
Figure 30: Field Selection Editor 

C H A P T E R  6  
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Field Descriptions 
Category  General field filter, based on the Content Editor fields.  Options include System (Content Editor 
system fields) Shared (Content Editor shared fields), Local (Content Editor local fields), and All (all fields 
for Content Editors).  Default is System. 

Field Filter  Filter that further screens by only choosing those that match the characters entered in the text 
box.  Can take any regular expression as a value.   

Available Fields  Displays selected fields. 

Available Fields Display Label  Read only.  The name of the field displayed to Business Users. 

Available Fields Field  Read only.  The name of the field used for processing in the Rhythmyx server. 

Available Fields Data Type  Read only.  The type of data stored in the field. 

Selected Fields  This table lists all fields selected to use in the Display Format, Search, or View. 

Selected Fields Display Label  Read only.  The name of the field displayed to Business Users. 

Selected Fields Field  Read only.  The name of the field used for processing in the Rhythmyx server. 

Selected Fields Data Type  Read only.  The type of data stored in the field. 
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Selecting Fields used in Display Formats, 
Views, and Searches 
Select the fields that display in Display Formats, standard Views, or Searches with the Field Selection 
editor (on page 99). 

For definitions of the fields discussed below, see Field Selection editor (on page 99). 

To use the Field Selection Editor: 

1 Press the [Add Columns] or [Customize] button in the Display Format, View, or Search 
editor. 

The Field Selection editor opens in a separate window from the Rhythmyx Workbench. 

2 In the Category drop list, choose the type of fields you want to use in the Display Format, 
Search, or View.  Options include System (Content Editor system fields) Shared (Content 
Editor shared fields), Local (Content Editor local fields), and All (all Content Editor fields).   

3 In the Field Filter field, enter a filter.  This field accepts any regular expression.  

4 Click the Apply button .  

5 The Field Selection Editor displays the fields that meet the criteria you specified.  

6 To display all available fields in the category again, delete the entry in the Field Filter field 

and click   again. 

7 To add a field to the Display Format, View, or Search select the field in the Available Field 

table and click . 

The field moves to the Selected Fields table. 

The values available in some fields depend on the value you specify in another field.  If the 
second field is required by the first field, Rhythmyx includes it automatically.  If the second 
field is optional, Rhythmyx displays a message notifying you about the dependency and 
offering to include the dependency. 
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For example, if Content Type had an optional dependency on Community and you added the 
field Content Type to the Selected Fields table, Rhythmyx would display the following 
message: 

 
Figure 31: Optional Field Dependency dialog 

When entering criteria for a Search or View, the values available in the Content Type field 
depend on the Community selected.  If no Community is specified, all Content Types are 
available.  However, if you specify a Community, only Content Types associated with that 
Community are available. 

8 To remove a field from the Display Format or View, select the field you want to remove from 

the Selected Fields table and click the Delete button . 

9 The change the order of the fields in the Display Format or View, select a field in the Selected 

Field table and click the up  and down  arrows to move it to the correct 
position in the order. 

10 Click [OK] to close the Field Selection editor and enter your Selected Fields in the Display 
Format, View, or Search editor. 
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Extending Lifecycle Analysis 
Reporting 
Rhythmyx provides Content Administrators with the ability to retrieve content metadata from the 
Repository.   Report data is provided by Rhythmyx resources in one of two applications: 

 sys_reports 
The default data processing application for Lifecycle Analysis.  All Lifecycle Analysis 
resources provided by Percussion Software are stored in this application, and the default Excel 
file, LifecycleAnalysis.xls, is stored in this application directory.  When your system is 
upgraded, all files in this directory, including all application files, are overwritten with 
updated files.  Therefore, you should not modify any of these files. 

 rx_reports 
This application is provided for you to enhance and customize Lifecycle Analysis.  It is not 
overwritten during upgrades.  Any resources that you modify should be copied to this 
application before modification, and any new resources you develop should be added to this 
application.  If you modify the default Excel file (including to update the Rhythmyx 
properties), you should move it to this application directory before making any changes.  Any 
enhancements Percussion Software makes to the default Excel file during upgrade should be 
migrated to the copy of the file in this directory.   

The following options are available to enhance Rhythmyx Lifecycle Analysis: 

 Update default Lifecycle Analysis resources provided by Percussion Software 
You can enhance the reporting resources provided by Percussion Software to retrieve 
additional reporting data; for example, you might want to enhance the Content by Workflow 
Reporting by adding the currently assigned Roles.  Note that any time you enhance a default 
resource, you should first copy it from the sys_reports application to the rx_reports 
application.  If you do not copy the resource to rx_reports before modifying it, your changes 
will be overwritten when your system is upgraded.  For details, see Modifying the Fields in 
Standard Lifecycle Analysis Reports (on page 108). 

 Add new Lifecycle Analysis query  resources 
You can add additional resources that retrieve data about your content.  For example, you 
might want to add a query for Content Items that are in Pending or Quick Edit States (in other 
words, content that is ready to go Public, but is not currently Public).  Any new resources that 
you develop should be added to the rx_reports application.  Resources added to the 
sys_reports application will be deleted when this application is overwritten during upgrades.  
For details  see Adding Custom Lifecycle Analysis Report Resources (on page 111). 

C H A P T E R  7  
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When adding a Rhythmyx field that stores numeric data (such as a ID) to a resource, add the attribute 
"type" to the node, with a value of ""Number" (@type='Number').  This attribute ensures that 
Excel processes the output data for the field correctly.  If you do not include this attribute for a node, 
Excel will return a warning that the contents of the cell have been formatted as a number. 

 Add new reporting clients 
You can output Rhythmyx reporting data to other reporting clients, such as Crystal Reports.  
For details, see Implementing Lifecycle Analysis in Additional Clients (on page 115). 

NOTE:  Excel has a limit of 65,000 rows in any one spreadsheet.  Certain tables, such as the 
CONTENTSTATUS table, can easily exceed this limit.  When a table exceeds this limit, Rhythmyx 
returns an error message when attempting to open the LifecycleAnalysis.xls workbook.  To alleviate this 
problem, you may want to create duplicate resources that select smaller data sets. 

For a detailed discussion about using Microsoft Excel as a reporting tool, see Excel Advanced Report 
Development by Timothy Zapawa (Wiley Publishing, 2005, ISBN 0?7645-8811-7). 
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Updating the Rhythmyx Lifecycle Analysis 
Workbook 
The following custom properties have been added to the Rhythmyx reporting Excel file.  You should 
update the values of these properties with the correct local values in the copy of the file in 
<Rhythmyxroot>/rx_reports.  
(<Rhythmyxroot>/rx_reports/LifecycleAnalysis.xls).  If you do not update the values 
in this file, users will not be able to retrieve data from the Rhythmyx server when they attempt to use 
Lifecycle Analysis.    

Property Name Description Default Value Update 
rx_server Name or IP address of the 

Rhythmyx server (which is 
recommended?)  

127.0.0.1 Change the name or IP 
address to match that of 
your Rhythmyx server. 

rx_port Port on which the Rhythmyx 
server listens 

9992 Change the value to the 
port assigned to your 
Rhythmyx server. 

rx_protocol Protocol used to communicate 
with the Rhythmyx server 

http Should not be modified. 

rx_root Rhythmyx application root Rhythmyx Should not be modified. 

rx_resources Comma-separated list of 
resources in the rx_reports 
application. 

None Add the names of any 
resources you copy from 
the sys_reports 
application to the 
rx_reports application 
and of any new resources 
you develop and add to 
the rx_resources 
application. 

sys_resources Comma-separated list of 
resources in the sys_reports 
application 

ContentState, 
CommunityContent, 
StaleContent, PubStatus, 
ContentStatus 

If any new resources are 
added by Percussion 
Software, you should 
add them to your copy of 
LifecycleAnalysis.xls.  
Otherwise, you should 
not modify this property.

To update the properties: 

1 Right-click on <Rhythmyxroot>/rx_reports/LifecycleAnalysis.xls and 
from the popup menu, choose Properties. 

Windows displays the Properties dialog. 

2 Click the Custom tab. 

3 Select the property whose value you want to modify. 
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4 Enter the new value in the Value field. 

5 Click the [Modify] button. 

6 When you have finished modifying the values, click the [OK] button. 
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Access Control for Lifecycle Analysis 
Reports 
By default, only members of the Report Admin Role have access to Lifecycle Analysis resources, and thus 
can retrieve Lifecycle Analysis data.  You can grant users access to the Lifecycle Analysis reports by 
adding them to this Role.  For details about adding users to a Role, see the topic “Adding Users to a Role” 
in the Rhythmyx Server Administrator Help. 

Another option for granting access to Lifecycle Analysis data is to add more Roles to the rx_reports 
application ACL.  Add the Role to the ACL, and grant it Query access to the application. For details about 
modifying the application ACL, see “Editing an Application ACL” in the Rhythmyx Workbench Help.  If 
you add the Role to the ACL, you will also need to modify the Visibility of the Lifecycle Analysis Action 
Menu item.  You must move each Role you added to the rx_reports ACL to the Show field of the 
Visibility tab for the Lifecycle Analysis Action Menu item. 

The Lifecycle Analysis reports retrieve all eligible data for the report, regardless of Community.  Thus, 
while a user may see a Content Item listed in a report, they may not be able to access the Content Item if it 
is in a Community other than the currently logged Community of the user or if none of the user’s Roles 
are assigned to the current Workflow State of the Content Item. 
 



 

108 Rhythmyx Customizing Content Explorer 
 

Modifying the Fields in Standard Lifecycle 
Analysis Reports 
You can modify the fields included in a Lifecycle Analysis report by modifying the Rhythmyx resource 
used to generate the data for the report.  To modify a Lifecycle Analysis report: 

1 Open the Rhythmyx Workbench. 

2 Open the sys_reports application. 

3 Select the resource that generates the report you want to modify and click the copy button. 

4 Open the rx_reports application. 

5 Click the paste button to paste the report resource to the rx_reports application.  Remember to 
add a Default XSL stylesheet to the resource. 

6 Open the resource. 

7 Open the mapper. 

8 Add the backend table column whose data you want to include in the report to the Backend 
column of the mapper. 

When adding a Rhythmyx field that stores numeric data (such as an ID) to a resource, add the attribute 
"type" to the node, with a value of ""Number" (@type='Number').  This attribute ensures that 
Excel processes the output data for the field correctly.  If you do not include this attribute for a node, 
Excel will return a warning that the contents of the cell have been formatted as a number. 

9 In the XML column of the same row, add a new XML node for the output data. 

10 Close the mapper. 

11 Save the application. 

12 At this point, you can check that the resource returns the desired data by querying the resource 
directly.  Start a browser and enter the path to the resource in the address field.  The browser 
will return the results as a XML document.  Confirm that the new report field is included in 
the document and that it contains the data you expect. 

13 You must add the new resource to the rx_resources custom property of the Excel workbook.  
You may also want to remove the name of the resource from the sys_resources custom 
property.  (Each resource listed in these two properties creates a spreadsheet tab in the 
workbook.  If you do not remove the name of the resource from the sys_resources property, 
you will have two tabs with the same name, although the data will differ slightly.) 

14 Refresh the data in your workbook to confirm that you are retrieving the data you expect to 
see. 
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Example Modification of a Lifecycle Analysis Report 
Resource 
In this exercise, we will modify the Content By Community report, adding the column “Checked Out To” 
to list the user the currently has the Content Item checked out.  This data is stored in the 
CONTENTSTATUS.CHECKEDOUTUSERNAME column in the Repository database.   

To modify the Content By Community report: 

1 Copy the CommunityContent resource from the sys_reports application to the rx_reports 
application. 

a) In the Rhythmyx Workbench, open the sys_reports application. 

b) Select the CommunityContent resource. 

c) Click the copy button. 

d) Open the rx_reports application. 

e) Click the paste button. 

Rhythmyx adds the CommunityContent resource to the sys_reports application. 

2 Map the CONTENTSTATUS.CHECKEDOUTUSERNAME column to a new node in the 
DTD, named Checked_Out_To: 

a) Double-click on the CommunityContent resource. 

Rhythmyx opens the Mapper for the resource. 

b) Find the CONTENTSTATUS.CHECKEDOUTUSERNAME column and drag it to the 
first empty row in Back-end column of the Mapper. 

c) Double-click in the XML column of the Mapper and add the new DTD element.  This 
element must be a child of the Content element, so enter the new element as follows: 

Content_By_Community/Content/Checked_Out_To 

Remember to add the underscores.  The macros in the LifecycleAnalysis.xls workbook 
will replace them with spaces, but the underscores are required in Rhythmyx. 

  
d) To test your modification, start a browser session and query the resource.  Enter the 

following value in the Address field: 
http://localhost:9992/Rhythmyx/rx_reports/ContentCommunity.xml 
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Your  browser should display a result similar to the following: 

  
Note that the new column Checked_Out_To creates a new node.  If the new node is not in 
the correct location, confirm that you added it as a child of the Content node. 

3 Add the CommunityContent resource to the list of resources in the rx_reports custom property 
of the Excel workbook and remove it from the list of resources in sys_reports custom 
property. 

4 Log in to Content Explorer, go to a Site Folder and retrieve the report.  Note that the Checked 
Out To column has now been added to the report. 

 
Figure 32: Updated Content by Community report in Microsoft Excel showing the new column 
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Adding Custom Lifecycle Analysis Report 
Resources 
To add a custom Lifecycle Analysis report to your system, determine the backend columns you want to 
include in the report.  Define a DTD that includes these rows.  (NOTE:  Each node in the DTD that is 
associated with a Rhythmyx field that stores numeric data [such as a an ID] should include the attibute 
"type" with a value of "Number" [@type='Number'].  If you do not include this attribute with these 
fields, Excel will return a warning that the contents of the cell have been formatted as a number.)  For 
details about the correct structure of this DTD, see Implementing Lifecycle Analysis in Additional Clients 
(on page 115). 

Drop this DTD into the application rx_reports to create a new Query resource.  Add the backend tables to 
the application Datatank, creating joins on Content ID and Revision ID.  Map the data from these tables to 
your DTD. Save the resource and give it a name that identifies the data it produces.  Query the resource 
directly and review the resulting XML document to confirm that the resource is producing the data you 
expect.   

Now add the name of the resource to the rx_resources custom property of the Excel workbook.  When you 
refresh the workbook, you will see a new spreadsheet tab with the name in the root element of your DTD, 
and a column for each of the backend table rows defined in the DTD and in the application. 
 

Example Creation of a Custom Lifecycle Analysis Report 
Resource 
In this example, we will create a report with a Pivot Table that shows the Content Items in Pending and 
Quick Edit States.  This is content that is not currently Public, but is ready to be Public.  We will call the 
report Pending Content.  It will consist of the following columns: 

 Content ID 
 Current Workflow State 
 Creator 
 Last Modifier 
 Date Entered the current State 

To create the Pending Content Report: 

1 Create a DTD for the report.  The root element of the DTD will be called Pending_Content.  
This element must contain one child element to create the rows in the report.  We will call this 
child element Content. The children of the Content element are the columns we want to add to 
the report.  (Note that the Content_ID element includes the attribute "type" with a value of 
"Number" as should any node associated with a Rhythmyx field that stores numeric data.)   
The DTD for this report will be: 

<?xml version="1.0" encoding="UTF-8"?> 
<!ELEMENT Pending_Content (Content*)> 
<!ELEMENT Content (Content_ID, Workflow_State, Creator, 
Last_Modifier, Date_Entered_State)> 
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<!ELEMENT Content_ID (#PCDATA)> 
<!ATTLIST Content_ID 
 type CDATA #IMPLIED 
> 
<!ELEMENT Workflow_State (#PCDATA)> 
<!ELEMENT Creator (#PCDATA)> 
<!ELEMENT Last_Modifier (#PCDATA)> 
<!ELEMENT Date_Entered_State (#PCDATA)> 

Save the DTD as PendingContent.dtd. 

2 In the Rhythmyx Workbench, open the rx_reports application, drop the PendingContent.dtd 
into it and from the popup menu, choose Query.  Rhythmyx creates a new resource named 
PendingContent, attached to the Default stylesheet. 

3 Add backend columns to the resource: 

a) In the data tab for your Repository database, select the CONTENTSTATUS table, drag it 
into the mapper and attach it as the data tank for the resource. 

b) Add the STATES table to the datatank.   

Adding the STATES table should create a join between the two tables on the 
WORKFLOWAPPID column.  If the join is not created, add it manually. 

c) Map the query.  The following graphic illustrates the desired mappings for this query: 

  
4 In the Selector, add a manual SQL statement to select Content Items in the Pending and Quick 

Edit Workflow States.  (The WHERE table does not allow you to define the nesting or 
WHERE clauses required to retrieve the correct data.)  In the FastForward implementation, 
the following SQL statement retrieves the desired data. 

SELECT CONTENTSTATUS.CONTENTID, CONTENTSTATUS.CONTENTCREATEDBY, 
CONTENTSTATUS.CONTENTLASTMODIFIER, STATES.STATENAME, 
CONTENTSTATUS.STATEENTEREDDATE FROM rxmaster.dbo.STATES STATES, 
rxmaster.dbo.CONTENTSTATUS CONTENTSTATUS  WHERE 
STATES.WORKFLOWAPPID = CONTENTSTATUS.WORKFLOWAPPID AND 
CONTENTSTATUS.CONTENTSTATEID=STATES.STATEID 
AND(STATES.STATENAME=’Pending’ OR STATES.STATENAME=’Quick Edit’) 

5 To test your modification, start a browser session and query the resource.  Enter the following 
value in the Address field: 

http://localhost:9992/Rhythmyx/rx_reports/PendingContent.xml 
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Your  browser should display a result similar to the following: 

  
6 Add the PendingContent resource to the list of resources in the rx_reports custom property of 

the Excel workbook and remove it from the list of resources in sys_reports custom property. 

7 Log in to Content Explorer, go to a Site Folder and retrieve the report.  

  
8 Use the Pivot Table and Pivot Chart Wizard to create the Pivot Table. 

a) In the Excel Menu bar, choose Data > Pivot Table and Pivot Chart Report…. 

b) Excel displays the first dialog of the Pivot Table and Pivot Chart wizard. In the Where is 
the data that you want to analyze list, select the Microsoft Office Excel list or database radio 
button.  In the What kind of report do you want to create list, select the Pivot Table radio 
button.  Click the [Next] button. 

c) Excel displays the second dialog of the Pivot Table and Pivot Chart wizard.   Leave the 
default selection (all cells) in the Range field and click the [Next] button. 

d) Excel displays the last dialog of the Pivot Table and Pivot Chart wizard.  Select the New 
worksheet radio button and click the [Finish] button. 
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e) Excel displays a pivot table template and a list of fields to add to the table.  Add the Last 
Modifier field to the Row section of the template, the Workflow State field to the Column 
section of the template, and the Content ID field to the Data section of the template.  
When you finish, the results should resemble the following screenshot: 

  
Change the name of the new pivot table worksheet to “Pending Content by User”.  You may 
want to delete the original report worksheet before saving the workbook. 
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Implementing Lifecycle Analysis in 
Additional Clients 
To implement Lifecycle Analysis in a different client, you will need to consume the Lifecycle Analysis 
XML data generated by Rhythmyx, and add a means for the client to retrieve and update the data. 

The DTD for XML documents output by Lifecycle Analysis resources has a simple structure that parallels 
the structure of the <table>, <tr> and <td> tags in HTML: 

 The root element of the DTD document is equivalent to the HTML <table> tag.  It creates the 
root element of the output XML document.  In Excel, the value of this element is used as the 
name of the spreadsheet tab containing the data. 

 The root element must contain one child element, which is equivalent to the <tr> tag in 
HTML.  This element creates the rows in the spreadsheet. 

 The “row” element contains one child element for each row in the report.  These elements are 
equivalent to the <td> elements in HTML.  Each creates a cell in the spreadsheet. 

The Lifecycle Analysis client must be able to parse XML that conforms to this pattern to generate a 
spreadsheet tab. 
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Passing HTML Parameters to a Lifecycle 
Analysis Resource 
The macros attached to the LifecycleAnalysis.xls file allow you to pass HTML parameters to the resource.  
This feature allows you some flexibility in determining the output of the Lifecycle Analysis report.   

Normally, when adding a Lifecycle Analysis resource to the rx_resource custom property you add only 
the name of the resource.  If you want pass an HTML parameter to a resource, you must add the .xml 
extension to the name of the resource, and add the HTML parameter using standard HTML coding 
(resourcename.xml?parametername=value).   

For example, the Publish Status Summary report returns data from the last three editions published by 
default.  If you publish several times a day, such as hourly, the default configuration would not provide an 
accurate portrait of the content on your site.  To ensure an accurate representation, you would want to 
retrieve data for the last twenty-four Editions published.  To change this configuration, you will want to 
pass the parameter maxResults with a value of 24 to the PublishStatus report resource.  In the rx_resource 
custom property, change  

PubStatus 
to 

PubStatus.xml?maxResults=24 
You can also change the configuration of any reports provided with Rhythmyx.  The Stale Content report 
uses the HTML parameter daysuntouched to determine the minimum number of days a Content Item can 
go unmodified before being included in the report.  The default value of this parameter is 7. 

StaleContent.xml?daysuntouched=7 
If you wanted to change the minimum number of days for a Content Item not to be modified before being 
included in this report, change the value of the daysuntouched parameter.  For example, if you wanted to 
see only Content Items that have not been modified in a month rather than a week you might change the 
value of the parameter to 28: 

StaleContent.xml?daysuntouched=28 
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Upgrading Lifecycle Analysis 
To ensure that you do not lose modifications when you upgrade, Rhythmyx provides two reporting 
applications, as described in Extending Lifecycle Analysis Reporting (on page 103).  After you upgrade, 
you will need to migrate any enhancements from the sys_reports application to the rx_reports application.  
Similarly, you will need to migrate enhancements to the LifecycleAnalysis.xls workbook file from the 
copy in sys_reports to the copy in rx_reports.   
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Customizing DocuComp 
Integration 
Rhythmyx uses the DocuComp engine to compare text Content Items.  Configuration of this engine in 
Rhythmyx is controlled by the configuration file: 
(Rhythmyxroot)\rxconfig\Server\requestHandlers.compare.xml.  To change the configuration, change the 
values of the configuration options in the file.  The options available include: 

Attribute Available 
Values 

Default 
Value 

Remarks 

dcGranularity 

 

0-100 

 

20 Specifies the minimum granularity of a match.  The 
granularity defines the minimum number of characters 
to compare. 

dcMoveSense 

 

Any integer 
greater than 
zero. 

100 Specifies the minimum number of characters to 
consider as being classified as a move.   If a string of 
characters shorter than this value is moved, it will be 
treated as though it was deleted and pasted back.  A 
string equal to greater than this value will  be treated 
as though it was moved. 

dcPunctuation 0 (false) 

1 (true) 

0 Specifies whether to consider punctuation (as defined 
by the punctuation character set) to be part of a word 
or as standalone text. 

0: punctuation is not treated as part of the word. 

1: punctuation is treated as part of the word. 

dcOldPrgmList 0 (false) 

1 (true) 

0 Specifies whether to treat the old (original) stream as a 
line based listing. If set to true (1), the minimum 
sequence for comparison is a full line of text. 

dcNewPrgmList 

 

0 (false) 

1 (true) 

0 Specifies whether to treat the new (modified) stream as 
a line based listing. If set to true (1), the minimum 
sequence for comparison is a full line of text. 

dcHTML 

 

0 (false) 

1 (true) 

1 Specifies whether to run the comparison in HTML 
mode. If set to true, DocuComp does not evaluate 
HTML markup (data surrounded by the “<” and “>” 
characters) 
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Making Rhythmyx Accessible to 
Visually Impaired Users 
Rhythmyx includes accessibility options that make Content Explorer and Content Editors more usable for 
visually impaired users and other users who use screen readers, special screen display options, and 
keystrokes for navigation. 

The recommended operating system and browser to use with Rhythmyx’s accessibility options are: 

 Microsoft Windows XP Pro or Home 
 Internet Explorer 5.0 and above 

The accessibility features in Rhythmyx for visually impaired users include: 

 Compatibility with screen reader applications.  
Screen reader applications verbally describe user interfaces and screen contents.  They also 
voice keystrokes for performing navigation and commands. See Using Content Explorer with 
a Screen Reader (on page 122) for more information. 

 Keystrokes for navigating and using Content Editor controls.  
Implementers can specify keystrokes for Content Editor controls in a Content Editor field’s 
Field Properties dialog.  See “Creating a New Field” in the document Implementing Content 
Editors. Rhythmyx also includes a large number of keystrokes for navigation.  See 
“Navigating with Keystrokes” in the Content Explorer Online Help.  

 Ability to import the operating system’s magnified font settings and high resolution color 
schemes.  The fonts and color schemes configurable in Windows XP Screen Magnifier, which 
is accessible from the Windows Accessories screen, work well with Content Explorer. Users 
can save operating system settings in the Content Explorer Display Options dialog. See 
“Changing Content Explorer Options” in the Content Explorer Online Help for more 
information.  

Some components of  the Content Explorer interface do not support Accessibility features.  Users cannot 
use screen reader applications with these components or apply system settings to them.  The user interface 
components that do not support Accessibility are: 

 The Comparison Page (accessed from the View > Compare option in the Action Menu) 
 Preview Pages (accessed from the Preview > [Variant] option in the Action Menu) 
 Page Assembly Windows (accessed from the Active Assembly > [Variant] option in the 

Action Menu, Content Editor links, and by activating Site Explorer pages or snippets)   
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Using Content Explorer with a Screen 
Reader 
Screen reader applications vocalize user interface tags and labels and keystroke combinations for 
executing commands. Content Explorer includes components with the necessary tags and labels as well as 
default and customizable keystrokes to enable screen reader applications to describe its appearance and 
functionality to users.   

The recommended screen reader for use with Rhythmyx is: 

  JAWS 5.0 Professional Windows XP Pro or Home  

The Rhythmyx applet is a Java application; to enable JAWS to interact with Rhythmyx, you must also 
use: 

  Sun Microsystem’s Java Access Bridge 
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Setting up the Active Assembly 
Tutorial 
The Active Assembly interface's Help menu includes an Active Assembly Tutorial option. If you want 
your users to be able to follow the tutorial using the examples it provides, you must install a copy of 
Rhythmyx with FastForward and follow the instructions below under Tutorial Setup with FastForward.  If 
you want to customize the tutorial, follow the instructions under Customizing the Tutorial.  Otherwise, you 
can follow the instructions under Tutorial Without Setup.  

Tutorial Setup with FastForward 

Install Rhythmyx with FastForward in a sandbox that is accessible to content contributors who take the 
tutorial.    

To allow a content contributor to use the tutorial's examples: 

1 Log in as admin1 under the Community Enterprise_Investments.  

2 To allow a content contributor to create a content item without having to log out and log in as 
a different user: 

In Content Explorer's Workflow tab, assign the QA Role as an Assignee in the Standard 
Workflow's Draft State. For help performing this task, see the Content Explorer help. You 
only have to do this the first time you set up the sandbox. 

3 Copy the Site you have set up so that after each user takes the tutorial, you can delete the 
user's modified version and replace it with the copy of the Site that you have just set up. 
Follow the instructions under Creating a Test Site (see page 125). 

4 Assign the qa1 FastForward user to the content contributor taking the tutorial to limit access 
to Content Explorer's Content tab. Be careful not to give content contributors access to content 
items that you are using for your own testing. 

5 After each content contributor has completed the tutorial or at time intervals that you 
determine, reset the FastForward content to its original state by following the instructions 
under Refreshing the Test Site (see page 132).  

Customizing the Tutorial 
To customize the Tutorial to refer to your own content, modify the HTML files located in <Rhythmyx 
root>/Docs/Rhythmyx/Active_Assembly_Tutorial. Back up the customized tutorial because each time you 
upgrade Rhythmyx, your copy will be overwritten with the original version. Set up a Site that users can 
use with the tutorial, and set up content in the Site to reflect the examples in your tutorial. 

Copy the Site you have set up so that after each user takes the tutorial or at time intervals that you 
determine, you can delete the user's modified version and replace it with the copy of the Site that you 
originally set up. Follow the instructions under Creating a Test Site (see page 125). 
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To delete each tutorial user's modified version of the Site and replace it with your original set up, see 
Refreshing the Test Site (on page 132). 
Tutorial Without Setup  

If you do not set up FastForward content to work with the original tutorial or customize the tutorial to 
work with your test content, your content contributors can still follow the tutorial.  In the sandbox that you 
use to train content contributors, you should provide content items with a number of Slots filled in with 
Snippets that they can work with in Active Assembly. The content items must not be in a public State and 
must be available for check out by content contributors who take the tutorial. If you use this method, users 
may not be able to perform every step in the tutorial, but will learn how to use the major features of the 
interface.  
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Creating a Test Site 
After you set up the tutorial Site in your sandbox, you must copy it to a test Site.  Users who take the 
tutorial will only work on the test Site. The original tutorial Site becomes a backup for refreshing the test 
Site so that new users who take the tutorial are presented with unmodified content. 

In the following instructions, we assume that you are using FastForward.  If you are using your own 
content, follow the instructions, but replace your Communities, Sites, and Site Folders with the ones that 
we refer to in the following steps. 

To create the test Site: 

1 Copy the Enterprise_Investments and Enterprise_Investments_Admin Communities (or 
whichever Communities are associated with the Site you intend to copy) to other 
Communities in the Rhythmyx Workbench before creating the test Site. If you want your 
users to be able to follow the tutorial exactly as it is written, copy Enterprise_Investments to 
EI_Tutorial and Enterprise_Investments_Admin to EI_Admin_Tutorial. When you 
subsequently recreate the Site, you do not have to repeat this step. Note: See the Rhythmyx 
Workbench Help for help copying the Communties. 

2 After you have set up your Tutorial, right-click the EnterpriseInvestments Site folder or your 
custom Site Folder and choose Copy. 

3 Right-click on the root Site Folder and choose Paste > As Copy. 
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The Copy Site wizard opens. 

 
Figure 33: Copy Site Wizard 

4 Press [Next]. 

The wizard moves to the next page. The New Folder Name and New Site Name fields are 
empty. 
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5 Enter names in New Folder Name and New Site Name. If you want your users to be able to 
follow the tutorial exactly as it is written, enter Enterprise Investments Tutorial in New Folder 
Name and enter EnterpriseInvestmentsTutorial in New Site Name. 

 
Figure 34: Copy Site Wizard, second page 

6 Click [Next]. 
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The wizard moves to the next page.  

 
Figure 35: Copy Site Wizard, third page 

7 Click Copy Site Folders, Navigation and Content. 

8 Click [Next]. 
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The wizard moves to the next page. 

 
Figure 36: Copy Site Wizard, page 4 

9 Click Copy Content as new copy. 

10 Click [Next]. 

The wizard moves to the next page, which allows you to choose different Communities for 
your copied folders and content. 
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11 If you have copied the Enterprise_Investments and Enterprise_Investments_Admin 
Communities (or the Communities associated with the Site that you are copying) choose the 
copies under Target Community.  

 
Figure 37: Copy Site Wizard, Map Community Page 

12 Click [Next]. 

The wizard moves to the next page, which confirms your choices. 

13 Click [Next]. 

After the wizard completes its processing, it closes.  Content Explorer displays your new Site 
folder. Note that the content in this folder is all in the Draft State and is created by the user 
rxserver. Our setup instructions and the tutorial take this into account. 

 
Figure 38: New Site in Content Explorer 

14 Change your log-in Community to EI_Tutorial. 
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15 Go to EnterpriseInvestmentsTutorial/MortgagesAndHomeFinance/HomePurchase and check 
out the item 10 Steps to Demystifying the Mortage. You must do this each time you create the 
test Site. 

The purpose of doing this is to allow users who take the tutorial to see the checked out to 
someone else icon overlaid on an item in the Active Assembly interface.  

16 Determine how often new users will take the tutorial, and refresh the test Site (see page 132) 
at appropriate intervals. 
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Refreshing the Test Site 
How often you refresh your test Site depends on how many users are taking the tutorial and how long the 
new Active Assembly interface has been available. For example, when you initially install Rhythmyx with 
the new Active Assembly interface, you might want to refresh the test Site twice a day, but as time goes 
on, you may only refresh it every few days.  You should keep your users informed of how frequently you 
are refreshing the Site so they know when to take the tutorial. 

To refresh the test Site: 

1 In Content Explorer, go to the Publishing tab and click Sites/By Name. 

You should see your test Site (Enterprise Investments Tutorial) listed. 

 

2 Click  to delete your test Site. 

3 Go to the Contents tab and locate and right-click on the tutorial Folder 
(EnterpriseInvestmentsTutorial) and choose Remove from Folder. 

 
Figure 39: Removing the tutorial folder 

The folder and its contents are removed. 

4 Follow the procedure under Creating a Test Site (see page 125), but omit Step 1. 
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